
Design Guide: TIDM-02013
EV/HEV (電気自動車とハイブリッド電気自動車) 向け、GaN 採
用、7.4kW 双方向オンボード チャージャのリファレンス デザイン

概要

PMP22650 リファレンス デザインは、7.4kW の双方向オ

ンボード チャージャを提示します。このデザインは、アクテ

ィブ同期整流機能付きの 2 相トーテムポール PFC とフル

ブリッジ CLLLC コンバータを搭載しています。CLLLC は
周波数変調と位相変調の両方を活用し、電圧の全範囲に
わたって出力のレギュレーションを実施します。このデザイ
ンでは、単一の TMS320F280039C マイクロコントローラ

を使用して PFC 段と DCDC 段の両方を制御します。ま

た、このデザインは TMS320F28P65x マイクロコントロー

ラでもサポートされています。複数の高速 GaN スイッチ 

(LMG3522-Q1) を使用して、高密度を達成しています。

電力密度が 3.8kW/リットルのオープン フレーム電源との

組み合わせで、96.5% のピーク システム効率を達成して

います。

このデザインでは、閉電圧および閉電流ループ モード

で、単一の C2000™ マイクロコントローラを使ってこの電

源トポロジを制御する方法を示します。このリファレンス デ
ザインのハードウェアとソフトウェアは開発期間の短縮を可
能にします。

リソース

TIDM-02013、PMP22650 デザイン フォルダ

TMS320F280039C、TMS320F28P650DK プロダクト フォル

ダ

AMC3330-Q1、AMC3302-Q1、UCC21222-Q1 プロダクト フォル

ダ

C2000WARE-DIGITAL-POWERSDK ソフトウェア フォル

ダ

TMDSCNCD280039C、TMDSCNCD28P65X ツール フォルダ

テキサス・インスツルメンツの™ E2E サポ

ート エキスパートにお問い合わせくださ

い。

特長

• 最大電力：7.4kW、ピーク効率：96.5%
• AC 90V～264V、AC：AC 240V TYP
• Vprim：公称 DC 400V、Vsec：DC 250V～450V
• 公称 500kHz の PWM スイッチング (200kHz～

800kHz の範囲) を行う CLLLC 共振タンクにより電力

密度を向上
• 1 次側のソフト スイッチングおよびゼロ電圧スイッチン

グ (ZVS) と、2 次側のゼロ電流スイッチング (ZCS) お
よび ZVS により効率を向上

• ロゴスキー コイル センサを使用したアクティブ同期整

流方式を実装することで効率を向上
• 制御補償器アクセラレータ (CLA) を搭載した 

TMS320F28003x デバイスをソフトウェアでサポートし

ているため、単一の C2000 マイクロコントローラを使用

して AC/DC および DC/DC 制御を統合した OBC 設
計が実現可能

• 1 つの CPU (CPU1) で AC/DC 段と DC/DC 段を制

御する TMS320F28P65x デバイスのソフトウェア サポ

ートを提供
• TMS320F28P65x の新しいハードウェア オーバーサ

ンプリング機能により CPU オーバーヘッドを低減

アプリケーション

• ハイブリッド車、電気自動車、パワートレイン システム

• DC 高速充電ステーション

• 電力変換システム (PCS)
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1 CLLLC システムの説明

オンボード チャージャ (OBC) は、電気自動車 (EV) やハイブリッド電気自動車 (HV) に不可欠な部品です。図 1-1 に示

すように、OBC は通常、AC/DC (力率補正 (PFC) 整流段) と絶縁型 DC/DC コンバータで構成されています。C2000 マ
イクロコントローラは、車載アプリケーションで求められる高度なデジタル電源制御を実装するように設計されています。詳
細については、『C2000 デジタル電源』と『C2000 EV』を参照してださい。

AC-DC

(PFC)

DC-DC

(Isolated)

+

± 

図 1-1. 代表的な OBC アーキテクチャ

ほとんどの EV レベル 1 およびレベル 2 のチャージャでは、一晩でバッテリをフル充電できることが強く求められていま

す。バッテリ容量が増加するにつれて、OBC はさらに大電力用に設計される必要があります。OBC の電力容量が大きく

なると、車内のスペースや冷却能力に余裕がなくなるため、電力密度や効率などの仕様がいっそう重要になります。

CLLLC (コンデンサ - インダクタ - インダクタ - インダクタ - コンデンサ) は、対称型のタンク、ソフト スイッチング特性、高

周波数でのスイッチング能力を備えており、このようなアプリケーションに適しています。このデザインでは、図 1-1 に示す 

CLLLC トポロジの制御と実装について説明します。

ISEC_TANK

VSEC

ISEC

BatteryPFC Power Stage

IPRIM_TANK
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VPRIM

IPRIM_TANK_2

CLLLC Resonant Tank

1H 2L1L 2H 1H 2L1L 2H

PRIM_LEG½_H/L SEC_LEG½_H/L

図 1-2. 絶縁型 DC/DC コンバータの CLLLC トポロジ

図 1-1 の用語は以下のとおりです。

VPRIM 1 次側電圧 (通常は PFC コンバータから供給されます)

IPRIM 1 次側のリターン電流。保護と監視に使用できます。

IPRIM_TANK、IPRIM_TANK_2
1 次側のタンク電流。シャント電流センシングとロゴスキー コイルを使用した 2 つのセンシング方

法があります。一つだけが必要で、たとえば、2 次側から 1 次側への逆方向の同期整流に使用さ

れます。また、保護にも使用されます。

VSEC 2 次側電圧 (通常はバッテリです)

ISEC 2 次側のリターン電流。バッテリ電流制御ループに使用されます。

ISEC_TANK 2 次側のタンク電流。たとえば、1 次側から 2 次側への順方向の電力フローの同期整流に使用さ

れます。

PRIM_LEG1/2_H/L 1 次側フル ブリッジ用 PWM

SEC_LEG1/2_H/L 2 次側フル ブリッジ用 PWM
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1.1 主なシステム仕様

CLLLC リファレンス デザインの電力仕様を 表 1-1 に示します。

表 1-1. 主なシステム仕様

パラメータ 仕様

1 次側電圧 (Vprim) DC 400V～450V (平均)

2 次側電圧 (Vsec)
DC 250V～450V
最大値

順方向電流定格 7.4kW

出力電流 (IOUT) 20
最大

効率 (CLLLC) ピーク 98%

PWM スイッチング周波数 公称 500kHz (200kHz～800kHz の範囲)

!

警告

テキサス・インスツルメンツは、このリファレンス デザインをラボ環境のみで使用するものとし、一般消費者向けの完

成品とはみなしておりません。 このデザインは室温で動作することを意図しており、他の周囲温度での動作はテス

トされていません。

テキサス・インスツルメンツは、このリファレンス デザインを高電圧電気機械部品、システム、およびサブシステムの

取り扱いに伴うリスクを熟知した有資格のエンジニアおよび技術者のみが使用するものとしています。

基板上は高電圧状態になっており、接触するおそれがあります。基板は、不適切に取り扱ったり、使用した場合に

感電、火災、けがの原因となる電圧および電流で動作します。けがをしたり、物品を破損しないために必要な注意

と適切な対策をもって機器を使用してください。

!
注意

電源を入れたままその場を離れないでください。

警告

高電圧！基板上は高電圧状態になっており、接触するおそれがあります。感電する可能性があります。基板は、不

適切に取り扱った場合に感電、火災、けがの原因となる電圧および電流で動作します。けがをしたり、物品を破損

しないために必要な注意と適切な対策をもって機器を使用してください。安全のため、過電圧/過電流保護機能を

備え、絶縁された試験装置の使用を強くお勧めします。

TI は、電圧/絶縁要件を確認 理解した上で基板やシミュレーションにて電圧を加えることをユーザーの責任と考え

ます。電源投入中は、回路およびその接続部品には触れないでください。

警告

表面は高温！触れるとやけどの原因になることがあります。触れないでください！

基板の電源を入れると、一部の部品は 55℃を超える高温に達することがあります。動作中は常に、また動作直後

も高温の状態が続く可能性があるため、基板に触れてはいけません。
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2 CLLLC システムの概要

2.1 ブロック図

図 1-1 に、CLLLC トポロジのブロック図を示します。

+

CLLLC Resonant Tank

AMC3330-Q1

PMP22712

VSECOPA320-Q1TTPLPFC_VBUS

,PFC Power Stage

OPA365-Q1IPRIM_TANK2

LMG3525-Q1 LMG3525-Q1

OPA365-Q1 ISEC_TANK

IPRIM AMC3302-Q1

PMP22712

ISEC

Battery

C2000 Microcontroller

TMS320F280039C

TMDSCNCD280039C  

TIDM-02013

図 2-1. CLLLC のブロック図

このリファレンス デザインでは、このガイドに記載されている動作を実現するために、以下の評価基板と PMP デザインを

使用しています。

1. OBC ベース ボード：PMP22650 (PMP22712 +PMP22773 ドーターカード搭載)
2. F280039C controlCARD 評価基板： TMDSCNCD280039C

以降のセクションでは、ハードウェア、ソフトウェア、システム設計の詳細について説明します。

2.2 設計上の考慮事項とシステム設計理論

LLC コンバータは、1 次側で ZVS、2 次側で ZCS を実現することができるため、広く普及しています。代表的な LLC 直
列共振コンバータ (SRC) を 図 1-1 に示します。このコンバータの 1 次側はハーフ ブリッジであるため、ボルト秒の観点

から考えると、トランスの利用率は半分になります。さらに、スイッチの電流定格は、フルブリッジ構造を使用する場合に比
べて、必要な電流の 2 倍となっています。

図 2-2. LLC ハーフブリッジ SRC
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ハーフブリッジ LLC SRC はコスト的には低消費電力で魅力的ですが、大電力で高密度のアプリケーションでは、次の理

由からフルブリッジ LLC SRC が必要とされます。

1. フルブリッジ LLC コンバータは、2 次側と 1 次側の両方でトランスの磁気コアをより効果的に活用するため、より高い

電力密度を提供することができます。
2. フルブリッジ LLC コンバータは電流定格を低減するため、配線内の銅にかかるコストが削減できます。また、このコン

バータは、同じ銅線で大電力 (ハーフブリッジ SRC と比べて) を実現することができます。

+

図 2-3. フルブリッジ LLC コンバータ

図 1-1 に示すように、フルブリッジ LLC コンバータは、広い意味でデュアル アクティブ ブリッジ (DAB) コンバータに分類

されます。DAB コンバータでは、コンバータはモデルまたは動作に基づいて分類できます。

1. 位相シフト型 DAB コンバータは、歴史的に見て、最も広く普及しているコンバータの一つです。

2. 共振 DAB コンバータでは、共振タンクにさまざまなバリエーションがあります (LC、LLC、CLLLC、CLLLC など)。

共振 DAB コンバータは、高効率、大電力、高密度が実現できることから、高い関心を集めています。CLLLC は、対称型

のタンクによって双方向動作が可能です。LLC 構造を双方向に使用する際の問題点は、逆方向の電力フローモードで動

作する場合のスイッチング周波数が、トランスの巻線容量と漏れインダクタンスに左右されることです。このため、電力段の
ゲインやスイッチング周波数はほぼ制御できません。このことから、CLLLC タイプの構造は、スイッチング周波数がより制

御しやすく、ゲインの自由度が増すため、好まれています。

2.2.1 タンクの設計

このセクションでは、必要な電圧ゲインやソフト スイッチング特性に基づいて CLLLC のタンク パラメータの選択について

説明し、CLLLC に基づいてチャージャに適した電力プロファイルを選択します。

その他の計算や情報については、ソフトウェア インストール パッケージ (C2000Ware_DigitalPower_SDK_<ver>/
solution/tidm_02013/hardware/) 内にある以下のファイルを参照してください。

2.2.1.1 電圧ゲイン

タンクの設計を理解するには、最初に、第 1 高調波近似を使用した第 1 高調波分析 (FHA) で、バッテリ充電モードと逆

方向パワーフローモードの両方のゲインを分析する必要があります。共振タンクの概略図を 図 1-1 に示します。

Crp Lrp
CrsLrs

RL
Vprim Lm

NCLLLC:1

Vsec

図 2-4. バッテリ充電モード (BCM) 時の CLLLC 共振タンクの FHA モデル

図 1-1 の用語は以下のとおりです。
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Vprim
(TTPLPFC_VBUS) 1 次側の入力電圧

Lrp 1 次側の共振インダクタ

Crp 1 次側の共振コンデンサ

NCLLLC トランスの巻線比

Lm 磁化インダクタ

Vsec 2 次側の出力電圧

Lrs 2 次側の共振インダクタ

Crs 2 次側の共振コンデンサ

RL 2 次側出力で FHA を使用した場合の実効負荷

ここで、実効 RL は 
L L _ dc2

8
R R

§ ·
 ¨ ¸

S© ¹  として計算され、RL_dc は出力における DC 抵抗性負荷であることに注意してくだ

さい。

1 次側で 2 次側の数量を参照すると、以下のようになります。

• Lrs' は Lrs * NCLLLC * NCLLLC と等しい

• Crs' は Crs / (NCLLLC * NCLLLC) と等しい

• RL' は RL * (NCLLLC * NCLLLC) と等しい

• Vrs' は Vrs * NCLLLC と等しい

Crp Lrp
&¶rs/¶rs

5¶LVprim Lm

9¶sec

図 2-5. BCM で 1 次側の数量を参照した FHA CLLLC

KCl と KVL を使用すると、ゲイン計算式は 式 1 のように記述できます。

� �
� � � �
m rs L L

sec

prim
rp m rs L rs L CLLLC

Z || Z R R
V

V Z Z || Z R Z R N

ª ºc c c�« »¬ ¼ 
§ ·ª ºc c c c� � �¨ ¸« »¬ ¼© ¹ (1)

同様に、逆方向の電力フローについても、回路は 図 1-1 に示すように簡略化でき、ゲインは 式 2 のように記述できます。

� �
� �� �� �

CLLLC m rp L Lprim

sec rs m rp L rp L

N Z || Z R RV

V Z Z || Z R Z R

ª º�¬ ¼ 
c ª º� � �¬ ¼ (2)

Crp Lrp
&¶rs/¶rs

RL Lm

Vprim

9¶sec

図 2-6. RCM におけるゲイン計算の FHA モデル
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式 1 と 式 2 は、設計用に選択されたパラメータに基づいて電圧ゲインを調べるために、以下のセクションで使用されま

す。

2.2.1.2 トランス ゲイン比の設計 (NCLLLC)

共振コンバータは通常、共振周波数ちょうどまたはその付近で動作するときに最も効率的です。今回の回路は双方向バッ
テリ チャージャなので、このデザインは特定の出力電圧範囲に対応する必要があります。このことは、I2R 損失を低減する

ために、コンバータができるだけ小さい電流で動作できるように、n を選択する必要があることを暗黙的に意味します。 こ
のデザイン コンセプトに従えば、最大電力を供給する必要がある最小出力電圧で、最大出力電流が流れることになりま

す。コンバータができるだけ共振に近い状態で動作するこのポイントに合わせて、n を設定します。このデザインでは、巻

線比は 1.1:1 になります。これにより、広い出力電圧範囲を許容しながら、損失を最小限に抑えることができます。

2.2.1.3 磁化インダクタンスの選択 (Lm)

1 次側 FET の ZVS 動作を確実に実現するには、共振タンクに蓄積されたエネルギーが FET の出力コンデンサに蓄積

されたエネルギーより大きいことを確認する必要があります。式 3 を使用して、フルブリッジ LLC SRC に必要な Lm を割り

出すことができます。

dead
m

oss

Tt
L

16 C
d



(3)

ここで、コンバータの想定されるスイッチング周波数は 500kHz であるため、T = 1/(500 * 103) となり、パワー デバイスに

基づいています。tdead や Coss のような選択されたパラメータは、パワー デバイスのデータシートから特定することもできま

す。通常、実効 Coss は、曲線近似を使用して計算する必要があります。このデザインでは、説明した設計パラメータに基

づき、Lm は 20µH 未満でなければなりません。上記の計算で考慮されている要素に加えて、実際のトランスには共振タン

ク電流によって放電される必要のある巻線間静電容量があります。したがって、シミュレーションを使用して、コンバータの
動作範囲全体で ZVS を確実に実現するために 14µH の値が選択されました。この値は以降の選択プロセスで使用され

ます。

2.2.1.4 共振インダクタとコンデンサの選択 (Lrp と Crp)

Lrp を選択する際には、Lm と Lrp の比が設計パラメータとして広く使用されます。

m
n

rp

L
L

L
 

(4)

Ln 値は、共振タンクの電圧ゲインがコンバータの動作範囲全体で十分になるように選択されます。このデザインでは、入

力電圧が PFC 段から供給され、推定 10% のリップルが発生するため、10% 以上のゲイン変動が必要です。この基準

と、インダクタ値、およびそれによる損失を低減するために Ln を高く維持する必要があるということを考慮に入れて、負荷

によって Ln が変化する FHA のプロットに基づいて、このデザインでは Ln は 14 が選択されます(図 1-1 を参照)。
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図 2-7. Ln の変化による CLLLC タンクのゲイン変動

Ln を選択したので、式 4 を使用して Lrp を計算できます。Lrp と Crp はコンバータの直列共振周波数を決定し、式 5 で表

されます。

res

rp rp

1
f

2 L C
 

S

(5)

式 5 は、設計に必要な Crp を計算するために使用できます。ただし、部品の入手可能状況により、設計には次に近い値

の Crp が使用されます。これらの部品値による BCM ゲインは、図 1-1 のとおりです。

図 1-1 では、負荷が増加する (RL_dc が低下する) と、直列共振周波数未満の領域でゲイン曲線は非単調になります。こ

れによって、ZVS が 1 次側 FET で失われ、さらに深刻なことに、制御ができなくなることにつながります。このため、公称 

Vout での最大負荷を想定した場合、負荷は RL_dc = 30Ω に制限またはクランプされ、このときゲインは単調になります 

(図 1-1 を参照)。

さらに 図 1-1 は、BCM では、200kHz～800kHz の動作周波数全体で十分なゲインがあり、すべての動作条件に対応で

きます。最後に、注目すべきは、PFC リップルを低減できれば、想定される入力範囲も小さくなるということです。これによ

り、必要なゲイン範囲が小さくなり、最終的にはすべての負荷条件に対応するために必要な周波数変動を低減できます。

2.2.2 電流および電圧センシング

以下のセクションでは、設計上のさまざまな電流および電圧に対するセンシング方式について説明します。設計上、ユー
ザーがアプリケーションのニーズに適した方式を選択できるように、複数の方式が実装されています。

2.2.2.1 VPRIM 電圧センシング

C2000 マイクロコントローラは 1 次側でバイアスされているため、1 次側電圧は、基板のグランドに接続された抵抗デバイ

ダによってセンシングされます。オーバーサンプリングが使用されるため、図 1-1 に示すように、ボルテージ フォロワ構成

のオペアンプを使用して ADC の信号をバッファします。バッファは ADC で認識されるインピーダンスを低減するのに役

立つため、より高速なサンプリング レートを使用することができます。そうでなければ、サンプリングは通常は高い抵抗分

圧器の抵抗の時定数によって制限されるため、低速サンプリングしかできません。
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+

±

Cf

Rf

VPRIM

Ra

Rb

図 2-8. VPRIM 電圧センシング回路

2.2.2.2 VSEC 電圧センシング

図 1-1 に示すように、2 次側電圧は AMC3330-Q1 を使用して絶縁された方法でセンシングされます。

Rc

Rc

Rd

Rfltr

Rd

Cfltr

+

± +

± 

VSEC

Ra

Rb

図 2-9. VSEC 電圧センシング回路

2.2.2.3 ISEC 電流センシング

図 1-1 に示すように、2 次側出力電流は AMC3302-Q1 を使用して絶縁された方法でセンシングされます。

Rc

Rc

Rd

Rfltr

Rd

Cfltr

+

± +

± 

ISEC

Rb

図 2-10. ISEC 電流センシング回路
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2.2.2.4 ISEC タンクおよび IPRIM タンク

図 1-1 に示すように、1 次側と 2 次側のタンクにおける高周波電流を絶縁された方法でセンシングするために、ロゴスキ

ー コイルをベースにしたセンシング メカニズムが選択されています。ADC ピンはコンパレータ サブシステム (CMPSS) に
内部接続されており、これによって、同期整流に必要な動作を実現するために、X-Bar を介して PWM に流れる適切なパ

ルスを生成することができます。

+

± 

MCU

Boundary

5RJRZVNL¶V�&RLO

Gain

Amplifier
Passive RC based

Integrator

On Chip DAC

On Chip DAC

Blanking Window

from PWM

X-BAR

ADC

Pin

CMPSS H

CMPSS L

Trip

Events to

PWM

To

CMPSS

V+

Current Carrying Conductor

+

± 

+

± 

Vref

図 2-11. ロゴスキー コイルを使用した ISEC タンクの電流センシング
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2.2.2.5 IPRIM 電流センシング

1 次側電流 IPRIM は、LMV796-Q1 を使用してセンシングされます (図 1-1 を参照)。

Rsh

IPRIM

To 

ADC

On Chip DAC

MCU 

Boundary

On Chip DAC

To 

CMPSS

+
-

+
-

On Chip DAC

CMPSS H

CMPSS L

X-BAR

Trip 

Events to 

PWM

Rsh

IPRIM

+
-

1.65V  

Reference

To 

ADC

MCU 

Boundary

+
-

+
-

Low Trip

High Trip

Typical Non C2000 MCU C2000 MCU

図 2-12. IPRIM 電流センシング回路、代表的なマイクロコントローラと C2000 マイクロコントローラとの比較

2.2.2.6 保護 (CMPSS および X-Bar)

大半のパワー エレクトロニクス コンバータは、過電流イベントから保護する必要があります。このデザインでは、複数のコ

ンパレータが必要であり、トリップ ポイントの基準を生成する必要があります。コンパレータ サブシステム (CMPSS) の一

部として、トリップ設定ポイント用の 12 ビット DAC とともにオンチップのウィンドウ付きコンパレータを搭載した、

TMS320F280039 などの C2000 マイクロコントローラを PWM モジュールに内部接続することで、外部ハードウェアを使

用することなく、PWM の高速トリップが可能になります。これにより、DAC、コンパレータ、ADC などのオンチップ リソース

を使用することで追加部品が不要になるため、最終アプリケーションで基板面積とコストが削減できます。これらのリソース
はすべて、外部接続を追加することなく、同時使用が可能です。さらに、CMPSS で生成された信号は X-Bar に送られ、

さまざまな独自の方法で組み合わされて、複数のソースからの特定のトリップ イベントにフラグを付与することができます。

Comparator Subsystem

DACLVAL

DACHVAL

COMPL

COMPH
+

± 

ADC

ADC Pin on 

C2000 MCU

To PWM Trip
+

± 

図 2-13. 過電流保護用のコンパレータ サブシステム (CMPSS)
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2.2.3 PWM 変調

図 1-1 に、このデザインで使用する PWM の波形構成を示します。

高分解能 PWM は 1 次側レッグと 2 次側レッグに使用され、PWM の生成にはアップダウン カウント モードが使用されま

す。高分解能 PWM を使用する場合、PRIM_LEG1_H PWM パルスは周期イベントの中心に配置され、タイム ベースは

アップダウン カウントに構成されます。その後、相補型スイッチ用に、高分解能デッドタイムを持つ相補型パルスが生成さ

れます。LEG1 と LEG2 の間には、フルブリッジ動作のために 180 度の位相シフトがあります。これは、PWM モジュール

の機能を使用して xA 出力と xB 出力を入れ替えることで実現します。(別の方法として、位相シフトを実装することもでき

ますが、このデザインでは必要ありません)。

2 次側への PWM パルスはアイソレータを通るため、さらに伝搬遅延が生じます。この伝搬遅延を考慮して、PWM を少し

進める必要があります。これは、1 次側アクティブ PWM パルスの立ち下がりエッジに対する位相シフト遅延によって行わ

れます。2 次側の位相シフトは、図 1-1 に示すように、アイソレータに必要な周期と遅延の組み合わせによるものです。ア

クティブ同期整流方式を使用しているため、立ち上がりエッジは 1 次側 PWM スイッチのタイミングによって制御されま

す。スイッチング イベントはノイズが多い可能性があるため、ブランキング ウィンドウを使用します。2 次側タンクの電流

は、動作周波数や負荷に応じて不連続になることがあります。そのため、立ち下がりエッジは、2 次側電流がゼロになった

直後にトリガされるトリップ動作によって制御されます。その後、次のゼロ イベントまたは周期イベントが発生するまでトリッ

プがラッチされ、ノイズによる 2 次側スイッチの意図しないオン動作を回避します。ブランキング パルスは PWM タイム ベ
ースによって生成されますが、トリップ ラッチ動作やブランキング動作は CMPSS の一部として行われます。タンク電流の

正の半分であるか負の半分であるかに応じて、2 つの異なるトリップ信号が生成され、X-Bar 経由で PWM モジュールに

送信されます。C2000 マイクロコントローラのタイプ 4 PWM は、これらのイベントを独自に使用して、アップ カウント中に 

xA パルスを、ダウン カウント中に xB パルスをトリップさせることができます。詳細については、セクション 5.1.2 を参照し、

ソリューションの HAL ファイルである関数 CLLLC_HAL_setupSynchronousRectificationAction() 内のコードを参照して

ください。

タイプ 4 PWM のグローバル リンク メカニズムは、レジスタの更新に必要なサイクル数を減らし、高周波動作を可能にする

ために使用されます。たとえば、関数 CLLLC_HAL_setupPWM() 内の以下のコードは、すべての PWM レッグの 

TBPRD レジスタをリンクしています。このリンクを使用すると、PRIM_LEG1 TBPRD レジスタへの書き込みを 1 回行うだ

けで、PRIM_LEF2、SEC_LEG1、SEC_LEG2 に値が書き込まれます。

EPWM_setupEPWMLinks(CLLLC_PRIM_LEG2_PWM_BASE,
                    EPWM_LINK_WITH_EPWM_1,
                    EPWM_LINK_TBPRD);

EPWM_setupEPWMLinks(CLLLC_SEC_LEG1_PWM_BASE,
                    EPWM_LINK_WITH_EPWM_1,
                    EPWM_LINK_TBPRD);

EPWM_setupEPWMLinks(CLLLC_SEC_LEG2_PWM_BASE,
                    EPWM_LINK_WITH_EPWM_1,
                    EPWM_LINK_TBPRD);

高分解能 PWM は前のサイクルでの残りの計算結果を次のサイクルに持ち越すため、位相関係を維持するために 1 次
側 PWM と 2 次側 PWM の間で周期的な同期を使用することはできません。周波数の変化やデューティの変化が検出さ

れるたびに、高速割り込みサービス ルーチンを使用して、ワンタイム同期が行われます (ISR1、セクション 5.1.2.2 を参

照)。
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図 2-14. CLLLC 設計に使用される PWM 方式、1 次側から 2 次側への電力フローによるアクティブ同期整流の場合

逆方向の電力フローについても同様に、使用されている PWM 構成を 図 1-1 に示します。
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CMPA

ISR1 Trig 

Writes from ISR1 to the 

global load registers will 

come in effect here

CMPA

TBPRD(1 ± dutyPrim)

(TBPRD/2)-delay

Blanking window Blanking window

dutySec(1-TBPRD)
CMPB

PRIM_LEG1_PWM 

PRIM_LEG2_PWM

TIMEBASE

SEC_LEG1_PWM

SEC_LEG2_PWM

TIMEBASE

CMPC=

TBPRD-20

Accounting for ISR latency 

the ISR will be services in 

this zone, where the global 

link registers are written to

dutySec*TBPRD

Minus 20 is used to offset 

for ISR latency (14 cycles 

+ some for context save)

xA is tripped when Time Base is counting UP

xB is tripped when Time Base is counting Down

RED FED

RED

FED

XBAR_TRIP5 ->

DCAL ->

DCAEVT2

XBAR_TRIP7 ->

DCBL ->

DCBEVT2

図 2-15. CLLLC 設計に使用される PWM 方式、2 次側から 1 次側への電力フローによるアクティブ同期整流の場合
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3 トーテムポール PFC システムの説明

警告

!  デバイスの電源を入れたままその場を離れないでください。

 高電圧！基板上は高電圧状態になっており、接触するおそれがあります。感電する可能性があ

ります。基板は、不適切に取り扱った場合に感電、火災、けがの原因となる電圧および電流で動作します。
負傷や物品の破損を避けるために、必要な注意と適切な対策をもって機器を使用してください。安全のた
め、過電圧および過電流対応の絶縁された機器の使用を強くお勧めします。テキサス・インスツルメンツは、
基板への電源投入やシミュレーション実行の前に、電圧要件および絶縁要件を確認し理解することがユーザ
ーの責任であると考えます。電源投入中は、回路およびその接続部品には触れないでください。

 表面は高温！触れるとやけどの原因になることがあります。触れないでください！基板の電源を入

れると、一部の部品は 55℃を超える高温に達することがあります。動作中は常に、また動作直後も高温の状

態が続く可能性があるため、基板に触れてはいけません。

3.1 トーテムポール ブリッジレス PFC の利点

すべてのプラグイン ハイブリッド電気自動車 (PHEV) では、車両内の電力グリッドと高電圧バッテリ パックの間にオンボー

ド チャージャ (OBC) が必要です。AC/DC 電力変換を行うために電力グリッドに直接接続し、ダウンストリームの DC/DC 
コンバータに流れる実際の電力を最大化するには、力率改善 (PFC) コンバータの実装が必須になります。

従来型の PFC コンバータには整流用に、現在ではパッシブ PFC 技術として知られているパッシブ ダイオード ブリッジが

実装されています。この方式の利点として、設計が簡単、信頼性が高い、低速のシステム制御ループ、低コストであること
が挙げられます。ただし欠点も明らかで、パッシブ部品は重量が重く、力率も低く、電力損失が大きいため、ヒートシンクが
かさばり、放熱が多くなります。この問題をさらに調査すると、幅広い主電源アプリケーションの低電圧ラインでは、入力ブ
リッジが入力電力の約 2% を消費することが判明しました。設計者が直列ダイオードのいずれかを抑制できれば、入力電

力を 1% 節約でき、その結果として効率を 94% から 95% に高めることができます (Turchi、Dalal、Wang、Lenck、2014 
年)。前述の欠点があるため、ブリッジ接続の従来型 PFC の定格電力は数百ワット未満に制限されています。特に、スペ

ースと重量の削減が重要な設計パラメータであるハイブリッド電気自動車 (HEV) や電気自動車 (EV) ではそれが顕著で

す。

その結果、従来のダイオード ブリッジをなくした、ブリッジレス アーキテクチャへと移行し続けています。OBC はシリコン 

パワー デバイスをベースとしており、低効率、低電力密度、高重量などの制限があります。SiC MOSFET の利点により、

設計者は、高速スイッチング、低逆方向回復電荷、低 RDS(ON) という優れた性能を活用することで、これらの制限を大幅

に改善することができます。

図 1-1 に、トーテムポール ブリッジレス PFC 昇圧整流器の基本構造を示します。1 つの昇圧インダクタ、2 つの高周波

昇圧 GaN スイッチまたは SiC スイッチ (下図の SiC1 と SiC2)、およびライン周波数で電流を流すための 2 つの部品で

構成されています。図 1-1 に示すように、ライン周波数の関連部品には 2 つの低速ダイオードを使用しても問題ありませ

ん。(A) に 2 つのシリコン ダイオード (D1 と D2) を示しています。(B) は、Si1 と Si2 を使用することで効率がさらに向上す

ることを示しています。
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図 3-1. トーテムポール ブリッジレス PFC 昇圧コンバータのトポロジ：(A) ライン整流用ダイオード、(B) ライン整流用 
MOSFET

トーテムポール PFC に固有の問題は、AC 電圧ゼロクロス時の動作モードの遷移です。AC 入力がゼロクロス時に正のハ

ーフ ラインから負のハーフ ラインに変わると、ローサイド高周波スイッチ SiC2 のデューティ比が 100% から 0% に変化

し、SiC1 のデューティ サイクルが 0% から 100% に変化します。ハイサイド ダイオード (または MOSFET のボディ ダイ

オード) の逆回復が遅いため、D2 のカソードの電圧はグランドから DC+ 電圧に瞬時にジャンプすることはできません (こ
れにより大きな電流スパイクが発生します)。この問題が原因で、設計者は Si MOSFET を連続導通モード (CCM) のトー

テムポール PFC に使用することはできません。したがって、SiC1 と SiC2 は、逆回復性能が低い窒化ガリウム (GaN) ま
たは SiC MOSFET の電界効果トランジスタ (FET) でなければなりませんが、TIDM-02013 では GaN FET を選択しまし

た。

トーテムポール PFC の最大の利点は、導通経路での電力損失が低減されることです。表 3-1 に、従来型 PFC とトーテ

ムポール PFC のデバイスの比較を示します。

表 3-1. ブリッジ接続の従来型 PFC とトーテムポール ブリッジレス PFC のデバイスの比較

パラメータ 低周波ダイオード 高周波ダイオード 高周波スイッチ 導通経路

ブリッジ接続の従来型 
PFC 4 1 1

低速ダイオード 2 個 + スイッチ 1 個また

は (低速ダイオード 2 個 + 高速ダイオー

ド 1 個)

トーテムポール ブリッジレ

ス PFC
2 ゼロ 2 高速 GaN スイッチ 1 個 + 低速 Si (また

は SiC) MOSFET 1 個

トーテムポール PFC の利点については、以下のとおりです。

• 従来型の PFC 昇圧コンバータは最も一般的なトポロジですが、その効率はフロント エンドのダイオード ブリッジ整流

器の導通損失の影響を受け、双方向ではありません。トーテムポール PFC は本来、双方向動作ができるようになって

います。
• ブリッジレス PFC 昇圧コンバータは、ダイオード数を大幅に削減し、電力密度を高め、効率を向上させています。

• この PFC は、高い効率、小さい同相モード ノイズ、小さい AC 電流リップル、小さい逆方向回復電流、少ない部品点

数という点で優れています。
• GaN ボディ ダイオードの低逆回復電荷、GaN FET の低ターンオン抵抗によって、このコンバータは双方向オンボー

ド チャージャ向けの効率的でコスト効率の優れたソリューションとなります。
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3.2 トーテムポール ブリッジレス PFC の動作

トーテムポール PFC は、AC 主電源入力の正サイクルと負サイクルでそれぞれ動作し、高周波 GaN MOSFET がどのよ

うにスイッチングされるかに応じて電流フローを決定します (それぞれ 図 1-1 と 図 1-1 を参照)。

高周波 GaN MOSFET とインダクタを組み合わせて、同期モード昇圧コンバータを構成します。正の半サイクル中、S2 は
デューティ サイクル D で駆動される昇圧スイッチで、S1 は相補型パルス幅変調 (PWM) 信号 (1-D) で駆動されます。図 

1-1 (A) は電流が流れる方向を示しています。同様に、S2 が 1-D でスイッチングされている間、S1 は D でスイッチングさ

れます。図 1-1 (B) は電流が流れる方向を示しています。このサイクル中、SD2 は連続的に導通しています。

負の半サイクル中は、ハイサイドとローサイドの高周波スイッチの役割が入れ替わることを除けば、動作はほぼ同じです。
図 1-1 は電流が流れる方向を示しています。このサイクル中、SD1 は連続的に導通しています。
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-
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+
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図 3-2. 正のハーフ サイクル中のトーテムポール ブリッジレス PFC の動作：(A) S2 ON 時、(B) S2 OFF 時
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図 3-3. 負のハーフ サイクル中のトーテムポール ブリッジレス PFC の動作：(A) S1 ON 時、(B) S1 OFF 時

このリファレンス デザインは、GaN FET (LMG3522R030-Q1) とテキサス・インスツルメンツの C2000™ Piccolo™ 

(TMS320F280039C) 高性能マイクロコントローラを使用しています。高周波 GaN FET は 120kHz のスイッチング周波

数で動作し、1 対の Si MOSFET はライン周波数 (約 45Hz～60Hz) で動作します。したがって、導通経路には 1 つの 

GaN スイッチと 1 つの低周波 Si スイッチがあり、導通損失が大幅に低減されています。導通損失と入力電流リップルを

低減するために 2 チャネル インターリーブが使用されており、テスト結果では 98.5% を上回る高効率を実証しています。
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3.3 主なシステム仕様

このデザインの主なシステム仕様を 表 3-2 に示します。

表 3-2. TIDA-02013 PFC の主なシステム仕様

パラメータ 仕様

入力

• 単相

• 電圧：約 90V ACRMS～264V ACRMS

• AC ライン周波数範囲：50Hz～60 Hz
• 入力電流：240V で 32ARMS_MAX、120V で 32ARMS_MAX

• 力率：≥ 0.99

出力

• PFC 出力：約 400V (代表値)
• 最大出力電力：約 400V で 7.4kW
• ピーク効率：98.5%

性能

• 高電圧リチウムイオン バッテリ OBC 用 PFC 段
• スイッチング周波数：120 kHz
• 絶縁：強化型

• 入力 AC センシング

• PFC 出力電圧センシング

保護

• 過熱保護

• 短絡保護

• 過電流保護

• 低電圧保護

• 過電圧保護
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3.4 システム概要

3.4.1 ブロック図

図 1-1 に、TIDM-02013 リファレンス デザインのシステム ブロック図を示します。このリファレンス デザインには、以下の

要素が含まれています。

• パワー スイッチ G1～G4 は高周波 GaN MOSFET で、各ハーフ ブリッジ レッグ間に 180° の位相シフトがあります。

G5 と G6 は低周波数 (40Hz～60Hz) の同期整流ブリッジを形成し、実質的にはスイッチング損失がありません。この 

2 つのデバイスには低導通損失の特性が求められます。

• TMS320F280039C C2000 リアルタイム マイクロコントローラがコントローラとして機能し、すべての電圧と電流のセン

サ入力を有し、G1～G6 用の正しい PWM 信号を生成します。また、コントローラはゲート ドライバ ボードからフォルト

信号を読み取り、フォルトが発生した場合にシステムをシャットダウンします。リセット機能は、起動時またはフォルトがク
リアされたときに使用されます。

• ホール センサは、合計入力電流と各チャネルの電流のセンシングに使用されます。分圧器は、入力ライン電圧、ニュ

ートラル電圧、および出力 DC バス電圧のセンシングに使用されます。

LN
+

G5

G6

G1

G2

G3

G4

図 3-4. TIDM-02013 PFC のブロック図

3.5 システム設計理論

3.5.1 PWM

図 1-1 にインターリーブ TTPL PFC 方式の単相概略図を示します。この整流器を制御するには、デューティ サイクルを

制御することによって、電圧を直接制御します。この電圧制御は、ソフトウェア変数 Duty または D が 1 と等しいとき Q3 
が常時オンになるように設定した場合に可能であり、この設定により電圧 VxiN は電圧 Vbus と等しくなります。Duty を 0 に
設定すると、Q3 はオンになりません。Q4 は常時 DC バスの負側に接続され、電圧が 0 になります。

Li

 D 

= duty

 commanded

 from the 

control loop

CAD
CLRCAD

SET

D

Q1

Q2

Q3

Q4

VxiN

VBus

ViN iLi

図 3-5. TTPL PFC の単相図

3.5.2 電流ループモデル

電流ループモデルを理解するには、まずインダクタ電流に注目します。図 1-1 では、スイッチ Q3 および Q4 に接続され

た PWM 変調器にデューティ サイクル (D) が設定されます。ここから、式 6 を次のように表します。
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VxiN = D × Vbus (6)

注

D を 1 に設定すると、Q3 は常時オンになり、D を 0 に設定すると、Q3 は常時オフになります。

インダクタを流れる電流を変調するには、Q3 スイッチ と Q4 スイッチのデューティ サイクル制御を用いて電圧 xiN
V  を制御

します。電流の方向は AC ラインから整流器に流れ込む方向で正となり、DC バス フィードフォワードおよび AC 電圧フィ

ードフォワードの使用時にはグリッドがかなり強力になると想定されます。図 1-1 に電流ループの概略図を示し、電流ルー

ププラントモデルを式 7 のように表します。

Hp_i = iLi*D = 1Kv_gain x Ki_gain × Gd x 1Zi (7)

ここで、

• v _ gainK  は、センシングされた最大バス電圧の逆数、 busMaxSense

1

V  です。

• i _ gainK  は、センシングされた最大 AC 電流の逆数、 AC_MaxSense

1

I  です。

• i _ fltrK  は、電流センサから ADC ピンに接続された RC フィルタの応答です。

• dG  は、PWM 更新に伴うデジタル遅延であり、デジタル制御は電流指令です。

•
*

Lii  は電流指令です。
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図 3-6. 電流ループ制御モデル

注

基準の負記号は、電流ループが電圧 xiN
V  を制御していると考えられるためです。電流を上げるには、 xiN

V  を
下げる必要があります。このため、図 1-1 の基準と帰還では記号が逆になっています。

次に、この電流ループモデルを用いて電流補償器を設計します。電流ループには、単純な比例積分(PI)コントローラを使

用します。

2 相インターリーブの場合は、各レッグに同じデューティ サイクルが設定されるため、電流は単純に 2 倍になります。この

ため、プラントモデルは式 8 のようになります。

Hp_i = iLi*D = 2 × 1Kv_gain x Ki_gain x Ki_fltr × Gd x 1Zi (8)
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3.5.3 DC バス電圧制御ループ

DC バス電圧制御ループは、基準電力を提供するものとされています。基準電力を入力電圧 RMS の 2 乗で割って導電

率を出し、さらに入力電圧を乗じて瞬時電流指令を求めます。

DC バス電圧制御ループの小信号モデルは、動作点周りで式 9 を線形化して作成します。

^
Nrms

DCDC bus Nrms Nrms Li
bus

V
i v V i i i

V
= h ® = h

(9)

抵抗性負荷の場合、バス電圧と電流は 式 10 に示すような関係にあります。

^ ^
L

bus DC

L o

R
V i

1 sR C
=

+ (10)

DC 電圧ループ制御モデルは、図 1-1 に示すように描写できます。制御ループがバス電圧に依存しないようにするため

に、追加の Vbus フィード フォワードが適用されます。したがって、バス制御のプラント モデルは 式 11 のように記述できま

す。

Hp_bus = Hload * η * 1Ki_gain *Kv_gain *Kv_fltr * Kv_gainKvac_gain (11)

Copyright © 2017, Texas Instruments Incorporated
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図 3-7. DC 電圧ループ制御モデル

図 1-1 を用いて、電圧ループ用に比例積分(PI)補償器を設計します。このループの帯域幅は、定常状態で THD と衝突

するため、狭く維持します。

3.5.4 電流スパイクを除去または低減するゼロクロス付近のソフトスタート

ゼロクロス電流スパイクは、TTPL PFC トポロジにおける一つの課題です。これは、ステート マシンによるソフトスタートの

手法を実装して、一定のシーケンスでスイッチのオン / オフを切り替えることで解決されます。
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図 3-8. ソフトスタートによる PWM シーケンスでゼロクロス時の電流スパイクを低減する

図 1-1 は、AC 波が負から正に移行するときのスイッチング シーケンスを示しています。負の半サイクル中は、Q1 がオ

ン、Q3 がアクティブ FET、Q4 が同期 FET となります。この間、Q2 を通る電圧は DC バス電圧となります。AC サイクル

が変わると、Q2 は 100%またはほぼ 100%オンになる必要があります。Q2 がすぐにオンになると、非常に大きな正のスパ

イクが生じます。このため、図 1-1 に示すようにソフトスタート シーケンスを用いて Q4 をオンにします。このソフトスタートの

調整は、インダクタンス値やその他の電力段パラメータ (デバイスの Coss など) に依存します。

ゼロクロス付近で負の電流スパイクが生じるもう一つの理由は、ゼロクロス付近の AC 電圧が比較的低いことです。Q3 が

オンになると、デューティ サイクルが低くても、高電圧差となり、高い負の電流スパイクが生じる可能性があります。このた

め、Q3 が再びスイッチング動作を開始する前に、十分な遅延を要します。

また、ソフトスタートの開始後に、いくらかの遅延ののち Q2 がオンになります。

3.5.5 電流の計算

式 12 で計算される最大入力電流に基づいて、入力ヒューズ、フィルタ電流定格を選択してください。

Iinrms = Pout_maxη ⋅ Vinrms ⋅ PF = 28 .2 A (12)

ここで、

• POUT_MAX は最大出力電力 6.6kW です。

• η は効率です (98.6% と想定)。
• VIN_RMS は入力電圧 RMS の値 (240V) です。

• PF は力率です (0.99 と想定)。

3.5.6 インダクタの計算

インダクタは、システム効率、電流リップル、全体のサイズに影響を及ぼす重要な役割を果たします。効率と電力密度のバ
ランスを常に考慮する必要があります。インダクタンスの値は、入力電圧、出力電圧、ワースト ケースのリップルに基づい

て計算します。
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デューティ サイクルは次のように計算されます。

D = 1 − VinVout (13)

インダクタへの電流リップルの計算は、次の 3 つの期間に区別できます。

Iripple = VinL − 2 × Vout − VinL × D × Ts For D ≤ 1/3 (14)

Iripple = 2 × VinL − Vout − VinL × D − 13 × Ts For 1/3 < D < 2/3 (15)

Iripple = 3 × VinL × D − 23 × Ts For D ≥ 2/3 (16)

ワースト ケースでは、式は次のようになります。

Iripple = Vout x Ts12 × L (17)

このデザインでは、最大入力電力と最大 AC 電流で 10% の電流リップルを達成することを目標にしています。

Iripple < 10% × 2 × Pout_maxVin_max × η (18)

ここで、

• Pout_max は最大出力電力です。

• η は効率です。

• Vin_max は最大入力電圧です。

その結果、インダクタンスは 12A RMS 電流で 126µH と計算されます。

3.5.7 出力コンデンサの計算

DC リンク コンデンサにおける入力のダブル ライン周波数リップルに起因して、DC リンク コンデンサの容量は、式 19 で
計算される出力電圧リップルに主に影響を受けます。

Cout min ≥ Pout/Vout4 ⋅ π ⋅ fline_min ⋅ Vripple_max = 860μF (19)

ここで、

• POUT は出力電力です。

• VOUT は出力電圧です。

• fLINE_MIN は最小ライン周波数です。

• VRIPPLE は出力リップルです。

実際に使用するコンデンサは 1410µF (3 x 470μF) です。
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3.5.8 電流および電圧センシング

ホール効果センサ ACS733KLATR-40AB-T は、図 1-1 に示すように、合計入力電流のセンシングに使用されます。

OPA320 ベースのアンプ回路は、センサの低出力電圧をより高いレベルに調整し、この電圧をコントローラの ADC ピンに

送ります。ACS733KLATR-40AB-T デバイスは、インターリーブされた各位相の電流をセンシングして、位相電流バランス

を可能にします。

+

±

Rf

Re

Re
Iinv

Current 

Hall -Effect

Sensor

図 3-9. ホール効果センサのシグナル コンディショニング回路

シグナル コンディショニング回路からの出力電圧は、図 1-1 に示すように、回路を使用して ADC 範囲と一致するようスケ

ーリングされます。電圧は次のように計算されます。

Iout = RfRe Iinv × Vno最小値alIno最小値al_max + Voffset (20)

10.0k
R155

3.48k
R149

PGND

PGND
PGND

PGND

3V3_PRI

3V3_PRI

16V
0.1uF

C215

C208

50V
100pF

C211

AC_L

IA
C

_P
H

1_
SE

N
SO

R

V
CC

15
V

CC
16

IP
+

1
IP

+
2

IP
+

3
IP

+
4

IP
-

5
IP

-
6

IP
-

7
IP

-
8

FA
U

LT
13

PR
O

G
RA

M
11

V
IO

U
T

12

VO
C

14

G
N

D
9

G
N

D
10

U47

A
C

S
73

3K
LA

TR
-4

0A
B-

T

4

3

2

1

5

V+
V-

OPA320AQDBVRQ1

U46

25V
0.1µF

C212

PGND

3V3_PRI

PGND

TTPLPFC_IAC_PH1
19.6

R148

16V
0.1µF

C209

PGND

IAC_PH1_SENSOR

16.5k

R154

16.5k
R145

1V65_REF

1V65_REF

PlaceOn Top

10.0k

R153

10.0k

R146

図 3-10. 電流センシングの回路図
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図 1-1 に示すように、入力 AC 電圧はラインをセンシングすることで差動的にセンシングされ、ニュートラル入力は 2 つの

分圧器で個別に制御グランドを参照します。制御グランドは DC リンクの負端子であるため、単一の分圧器を使用して 

DC バス電圧をセンシングできます。RC フィルタにより、コントローラに接続する前に信号がフィルタ処理されます。このデ

ザインでは、すべてのセンシング信号に共通の RC フィルタが使用されています。

TTPLPFC_VAC_L
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365k

R152

365k

R144

PGNDPGND

50V
470pF

C207
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R141
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図 3-11. AC 入力電圧センシング用分圧器の回路図
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4 主な使用製品

4.1 C2000 マイクロコントローラ TMS320F28003x
C2000™ 32 ビット マイクロコントローラは、処理、センシング、アクチュエーションに最適化されており、リアルタイム制御

アプリケーション、たとえば産業用モーター ドライブ、ソーラー インバータおよびデジタル電源、電気自動車および輸送、

モーター制御、センシングおよび信号処理などにおける閉ループ性能が向上しています。

TMS320F28003x (F28003x) は、重要な制御ペリフェラル、差別化されたアナログ、不揮発性メモリを 1 つのデバイスに

組み込むことができる、強力な 32 ビット浮動小数点マイクロコントローラ ユニット (MCU) です。

CLA により、一般的なタスクの負荷の多くをメインの C28x CPU から取り除くことができます。CLA は独立の 32 ビット浮

動小数点演算アクセラレータであり、CPU と並列に実行されます。さらに、CLA には独自の専用メモリ リソースがあり、一

般的な制御システムで必要となる主要なペリフェラルに直接アクセスできます。ANSI C のサブセット、およびハードウェア 

ブレークポイントやハードウェアによるタスク切り替えなどの主要な機能が標準でサポートされています。

F28003x マイクロコントローラには高性能のアナログ ブロックが内蔵されており、システムのさらなる統合が可能です。3 
つの独立した 12 ビット ADC により、複数のアナログ信号を正確かつ効率的に管理でき、最終的にシステムのスループッ

トが向上します。4 つのアナログ コンパレータ モジュールが、トリップ条件の有無を判断するために入力電圧レベルを継

続的に監視します。

TMS320C2000™ デバイスには、周波数に依存しない拡張パルス幅変調器 / 高分解能パルス幅変調器 (ePWM/
HRPWM) と拡張キャプチャ (eCAP) モジュールを備えた、業界をリードする制御ペリフェラルが搭載されており、クラス最

高レベルのシステム制御が可能です。シグマ デルタ フィルタ モジュール (SDFM) が内蔵されているため、絶縁バリアを

通して、オーバーサンプリング シグマ デルタ変調器をシームレスに統合できます。

さまざまな業界標準の通信ポート (シリアル ペリフェラル インターフェイス (SPI)、シリアル通信インターフェイス (SCI)、IC 
の相互接続 (I2C)、コントローラ エリア ネットワーク (CAN) など) により接続性がサポートされており、さまざまなアプリケー

ションにおいて最適な信号配置を行うための複数の多重化オプションを備えています。C2000™ プラットフォームの新機

能として、完全準拠のパワー マネージメント バス (PMBus) が追加されました。さらに、業界で初めて高速シリアル インタ

ーフェイス (FSI) による高速かつ堅牢な通信が可能になり、本デバイスに組み込まれている一連の豊富なペリフェラルを

補完します。

特別仕様の TMS320F28003xC では、構成可能ロジック ブロック (CLB) を利用して追加のインターフェイス機能を実現

できます。詳細については、『TMS320F28003x マイクロコントローラ データ マニュアル』の「デバイスの比較」表を参照し

てください。

組み込みのリアルタイム分析および診断 (ERAD) モジュールにより、追加のハードウェア ブレークポイントやプロファイリ

ング用のカウンタを使用できるようになり、デバイスのデバッグおよびシステム分析機能が強化されます。

高周波 CLLLC トポロジの制御を可能にするために、このデザインで特に強調されている C2000 マイクロコントローラの

機能の一部は、以下のとおりです。

1. 高分解能 PWM：ピコ秒単位の分解能を実現する C2000 マイクロコントローラの ePWM モジュールは、高周波 

PWM を高精度に生成できます。タイプ 4 PWM の高分解能周期制御に加えて、高分解能デューティ制御、高分解

能デッドバンド制御、高分解能位相シフト制御が可能です。これによって共振タンクの励起に適した平衡なパルスを
生成できるようになり、高周波パワー コンバータを実現する機能と言えます。

2. アクティブ同期整流用 ePWM 付きコンパレータ サブシステム (CMPSS)：アクティブ同期整流を使用すると、高い効

率が実現されます。共振点よりも低い周波数および高い周波数の両方で動作する高周波共振コンバータの場合、ト
ポロジに必要な機能となります。C2000 マイクロコントローラの内蔵 CMPSS では、内蔵コンパレータと内蔵 D/A コン

バータ (DAC) を使用することで、アクティブ同期整流パルスを生成できます。(セクション 2.2.2.4 を参照。)
3. ブランキング ウィンドウ：スイッチング コンバータでは避けられないノイズのため、ブランキング ウィンドウ機能を使用し

て、ノイズの多いスイッチング イベント中の CMPSS 出力を抑制します。このブランキング ウィンドウは ePWM タイム 

ベースによって提供され、PWM サイクルの異なるタイミングで適用できます。(セクション 2.2.3 を参照。)
4. X-Bar：1 つのパワー コンバータで複数のトリップ ソースを使用することができます。X-bar により、異なる CMPSS ま

たは GPIO からの異なるトリップ動作を組み合わせることで、外部ロジックなしで ePWM に必要なトリップ動作を生成

できます。
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5. 制御補償器アクセラレータ (CLA) により、複数のトポロジの制御を単一のコントローラに統合できます。このデザイン

で提供されるソフトウェアには、CLA または C28x で制御ループを実行するオプションがあります。

6. PWM モジュールのグローバル リンク機能 により、1 回の書き込みで複数の PWM を更新できるため、CPU の負荷

が軽減され、より周波数の高いコンバータを容易に制御できます。

4.2 LMG352xR30-Q1
LMG352xR030-Q1 は、ドライバ、保護機能、温度レポート機能を内蔵した、車載対応の 650V、30mΩ の GaN FET で
す。内蔵ドライバにより、最大 150V/ns のスイッチング速度を実現できます。テキサス・インスツルメンツの統合型高精度ゲ

ート バイアスは、外部ディスクリート ゲート ドライバと比較して、より広いスイッチング SOA をもたらします。この統合と低イ

ンダクタンス パッケージの組み合わせにより、ハード スイッチング電源トポロジでノイズの少ないスイッチングとリンギングの

最小化を実現できます。EMI を制御するための調整可能なゲート ドライブ強度、過熱保護、フォルト表示付きの堅牢な過

電流保護を含むその他の機能を使うと、BOM コスト、基板サイズ、フットプリントを最適化できます。高度な電源管理機能

には、デジタル温度レポートが含まれます。GaN FET の温度は可変デューティ サイクル PWM 出力により通知されるた

め、システムは負荷を最適に管理できます。

4.3 UCC21222-Q1
UCC21222 は、プログラミング可能なデッドタイムを備えた絶縁型デュアル チャネル ゲート ドライバです。ピーク電流はソ

ース 4A、シンク 6A で、パワー MOSFET、IGBT、GaN トランジスタを駆動するように設計されています。

UCC21222 デバイスは、2 つのローサイド ドライバ、2 つのハイサイド ドライバ、または 1 つのハーフ ブリッジ ドライバとし

て構成可能です。5ns の遅延マッチング性能により、内部貫通電流のリスクを伴わずに、2 つの出力を並列化して 2 倍の

駆動力で重負荷条件に対応できます。

入力側は 3.0kVRMS の絶縁バリアによって 2 つの出力ドライバと分離され、同相過渡耐性(CMTI)は最小で 100V/ns で

す。

抵抗によるデッドタイムのプログラミングが可能なため、システムの制約に合わせてデッドタイムを調整することにより、効率
を高め、出力のオーバーラップを防止できます。その他の保護機能：DIS を High に設定した場合に 2 つの出力を同時

にシャットダウンするディセーブル機能、5ns 未満の入力過渡を除去する内蔵グリッチ除去フィルタ、入力 / 出力ピンでの 

200ns にわたる最大 -2V のスパイクに対応する負電圧処理機能があります。すべての電源が UVLO 機能を備えていま

す。

4.4 AMC3330-Q1
AMC3330 は、デバイスのローサイドから単一電源で動作できる完全統合型絶縁 DC/DC コンバータを備えた高精度絶

縁型アンプです。その容量性強化絶縁バリアは、VDE V 0884-11 および UL1577 に準じて認定済みであり、異なる同相

電圧レベルで動作するシステムの各部を分離し、低電圧部分を損傷から保護します。AMC3330 の入力は、高電圧信号

を検出するために、抵抗分圧ネットワークなどの高インピーダンス電圧信号ソースに直接接続するよう最適化されていま
す。内蔵の絶縁 DC/DC コンバータにより非グランド基準信号を測定できるため、ノイズが多くスペースに制約があるアプ

リケーション向けの独自の設計として活用できます。

4.5 AMC3302-Q1
AMC3302 は、シャントを用いた電流測定に最適化された高精度絶縁型アンプです。完全に統合された絶縁型 DC/DC 
コンバータのおかげで、本デバイスの低電圧側から電力を供給する単一電源動作が可能であるため、スペースに制約が
あるアプリケーション向けのユニークなソリューションとして活用できます。その容量性強化絶縁バリアは、VDE V 0884-11 
および UL1577 により認証済みであり、最大 1.2kVRMS の使用電圧に対応しています。この絶縁バリアは、異なる同相電

圧レベルで動作するシステム領域を分離し、危険な電圧と損傷から低電圧側を保護します。AMC3302 の入力は、低イン

ピーダンスのシャント抵抗またはその他の信号レベルが小さい低インピーダンス電圧源と直接接続できるように最適化さ
れています。優れた DC 精度と小さい温度ドリフトにより、拡張産業用温度範囲 (–40℃～+125℃) にわたる高精度電流

測定に対応できます。
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5 ハードウェア、ソフトウェア、試験要件、試験結果

5.1 必要なハードウェアとソフトウェア

このセクションでは、ハードウェアの詳細について解説し、ボード上のさまざまなセクションと、この設計ガイドで説明してい
るように、実験用にそれらを設定する方法について説明します。

5.1.1 ハードウェアの設定

このデザインは高速エッジ カード (HSEC) の制御カード コンセプトを採用しており、HSEC 制御カードを利用できる 

C2000 マイクロコントローラ製品ファミリのデバイスであれば使用できる可能性があります。マイクロコントローラ の電力段

の制御に使用される主要なリソースを 表 5-1 に示します。このリファレンス デザインの主要な電力段とコネクタを 図 1-1 
に示します。表 5-3 に主要なコネクタとその機能を示します。

1. 基板に電源が接続されていないことを確認します。

2. J25 スロットに制御カードを挿入します。

3. 図 1-1 に示す J15 に、12V バイアス電源 (+12V、2A) の電源を接続します (電源は投入しないでください)。
4. バイアス電源の電源をオンにします。制御カードの緑色の LED が点灯します。これは、C2000 マイクロコントローラ 

デバイスに電力が供給されていることを示します。注：マイクロコントローラの電源バイアスは電力段と分離されている
ため、この一連の指示でシステムを安全に立ち上げることができます。

5. JTAG を接続するには、制御カードから USB ケーブルを使用してホスト コンピュータに接続します。

6. TTPPLPFC 段を動作させるには、AC 入力を J33 (90V～264V) に接続する必要があります。テストには 10kW を超

える電源が使用されていますが、低消費電力テストのみを実施する場合は、クリーンで安定した低定格電源を使用で
きます。

7. PFC 段のスタンドアローン動作の場合、負荷を J37 と J38 に接続することができますし、代わりに CLLLC を使用し

て PFC 段に負荷をかけることもできます。

8. CLLLC 段のスタンドアローン動作の場合、DC 電源 (400V) を J15 の VBUS に接続することができます。この場合、

ソフトウェアで TTPLPFC を起動せず、上記ステップ 6 で説明した AC 電源は接続しないでください。

9. 使用時は、CLLLC コンバータの 2 次側に負荷を接続する必要があります。このような負荷の接続には、J7 と J10 を
使用できます。

10. PFC 段と DCDC 段の両方を動作させる場合は、上記ステップ 6 のように AC 電源を接続し、上記ステップ 9 のよう

に負荷を接続します。VBUS への接続は必要はありませんが、OBC 実行後に余分な電圧を迅速に逃がすために、

電流ブリード抵抗が役立つ場合があります。
11. 電流プローブと電圧プローブを接続して、1 次側と 2 次側のタンク電流を観測できます。オプションとして、電力計を

接続して効率を測定することもできます。

ハードウェア、ソフトウェア、試験要件、試験結果 www.ti.com/ja-jp

30 EV/HEV (電気自動車とハイブリッド電気自動車) 向け、GaN 採用、7.4kW 双方向
オンボード チャージャのリファレンス デザイン

JAJU922A – OCTOBER 2022 – REVISED FEBRUARY 2024
資料に関するフィードバック (ご意見やお問い合わせ) を送信

English Document: TIDUF18
Copyright © 2024 Texas Instruments Incorporated

https://www.ti.com/jp
https://www.ti.com/jp/lit/pdf/JAJU922
https://www.ti.com/feedbackform/techdocfeedback?litnum=JAJU922A&partnum=TIDM-02013
https://www.ti.com/lit/pdf/TIDUF18


図 5-1. 基板の概要

赤色で示したバイアス電源ドーター カード 7 枚が必要です。

図 5-2. PMP22712 - バイアス電源

赤色で示したフィードバック絶縁ドーター カード PMP22773 1 枚が必要です。
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図 5-3. PMP22773 –フィードバック絶縁ドーター カード

表 5-1. 主なデジタル ピン構成

信号名 HSEC ピン番号 F28003x ペリフェラル

SYSTEM ISR Trigger - ECAP1

CLLLC_CONTROL_OUTPUT_DAC_PIN 14 DACA

CLLLC_PRIM_LEG1_H/L 49/51 EPWM1 (A/B)

CLLLC_PRIM_LEG2_H/L 53/55 EPWM2 (A/B)

CLLLC_SEC_LEG1_H/L 50/52 EPWM3 (A/B)

CLLLC_SEC_LEG2_H/L 54/56 EPWM4 (A/B)

CLLLC_FAULTn 74 GPIO-23 → INPUTXBAR2

CLLLC_LC_CHANGE 62 GPIO-14

CLLLC_SEC_SIDE_DIAG 80 GPIO-30

TTPLPFC_LOW_FREQ_H/L 57/59 EPWM5 (A/B)

TTPLPFC_HIGH_FREQ_PH1_H/L 61/63 EPWM6 (A/B)

TTPLPFC_HIGH_FREQ_PH2_H/L 58/60 EPWM7 (A/B)

TTPLPFC_FAULTn 72 GPIO-22 → INPUTXBAR1

TTPLPFC_INRUSH_RELAY_CTRL 64 GPIO-15

ERRORSTSn 102 GPIO55

SYSTEM_WATCHDOG_OUT
SYSTEM_WATCHDOG_DISABLE
SYSTEM_PMIC_SPI (予約済み)
SYSTEM_PMIC_SPI (予約済み)

75
77
79
81

GPIO24
GPIO25 (抵抗オプション)
GPIO26 (抵抗オプション)
GPIO27 (抵抗オプション)

SYSTEM_DISABLE_FET_SUPPLY 85 GPIO32

SYSTEM_TEMP_MUX_OUT1
SYSTEM_TEMP_MUX_OUT2

91
96

GPIO41 -> ECAP2 → INPUTXBAR3
GPIO60 -> ECAP3 → INPUTXBAR4

SYSTEM_TEMP_MUX_SEL_1-3 93
94
95

GPIO47
GPIO58
GPIO59

SYSTEM_PROFILING1～3 89
92
101

GPIO40
GPIO44
GPIO49

FSI_TX_D0
FSI_TX_D1
FSI_TX_CLK

101
103
105

GPIO-49/FSITXA_D0
GPIO-50/FSITXA_D1
GPIO-51/FSITXA_CLK
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表 5-1. 主なデジタル ピン構成 (続き)
信号名 HSEC ピン番号 F28003x ペリフェラル

LED1
LED2

82
86

GPIO-31 → LED1
GPIO-34 → LED2 (SFRA)

この表はリファレンス デザインのサンプリング方法を示し、上部の列はそれぞれ 1 つの独立した ADC を表しています。各 

ADC は互いに完全に独立して動作します。各信号には、1 つまたは複数の変換開始 (SOC) が割り当てられます。各 

SOC はそのチャネルの独立した 1 つの読み取りを表し、たとえば、TTPLPFC_IAC_PH1 は ADCA 内の SOC0 と 

SOC1 に割り当てられています。つまり、この信号はサイクルごとに 2 回サンプリングされ、1 回は ePWM6_SOCA によ

ってトリガされ、もう 1 回は ePWM6_SOCB によってトリガされるのです。このトリガは 120kHz で動作しているため、この

信号は各 120kHz のサンプリング期間中、実質的には 2 倍のオーバーサンプリングが行われます。同様に、

CLLLC_ISEC では 11 倍のオーバーサンプリングが行われ、CLLLC_IPRIM はオーバーサンプリングされません。また、

この表には、低周波サンプリング信号がいくつか示されており、これらの信号が異なる SOC 信号を使用していることがわ

かります。最後に、SOC を番号順に処理するためにラウンド ロビン カウンタが使用されているため、表はサンプリングの

順に上から下へ時系列に読み取れます。

表 5-2. 主なアナログ信号
ADC-A ADC-B ADC-C

最も優先度の高い信号

(120kHz)
TTPLPFC_IAC_PH1 (A2、CMPSS1)

SOC0 → ADC_TRIGGER_EPWM6_SOCA

SOC1 → ADC_TRIGGER_EPWM6_SOCB

TTPLPFC_IAC_PH2 (B12、CMPSS3)

SOC0 → 

ADC_TRIGGER_EPWM6_SOCA

SOC1 → 

ADC_TRIGGER_EPWM6_SOCB

TTPLPFC_VAC (C7)

SOC0 → 

ADC_TRIGGER_EPWM6_SOCA

SOC1 → 

ADC_TRIGGER_EPWM6_SOCB

CLLLC_ISEC (A5、CMPSS2)

SOC2 → ADC_TRIGGER_EPWM6_SOCA

SOC3 → ADC_TRIGGER_EPWM6_SOCA

SOC4 → ADC_TRIGGER_EPWM6_SOCA

SOC5 → ADC_TRIGGER_EPWM6_SOCA

SOC6 → ADC_TRIGGER_EPWM6_SOCA

SOC7 → ADC_TRIGGER_EPWM6_SOCA

SOC8 → ADC_TRIGGER_EPWM6_SOCB

SOC9 → ADC_TRIGGER_EPWM6_SOCB

SOC10 → ADC_TRIGGER_EPWM6_SOCB

SOC11 → ADC_TRIGGER_EPWM6_SOCB

SOC12 → ADC_TRIGGER_EPWM6_SOCB

TTPLPFC_VBUS / CLLLC_VBUS 
(B4)

SOC2 → 

ADC_TRIGGER_EPWM6_SOCA

SOC3 → 

ADC_TRIGGER_EPWM6_SOCB

SOC4 → 

ADC_TRIGGER_EPWM7_SOCA

SOC5 → 

ADC_TRIGGER_EPWM7_SOCB

CLLLC_VSEC (C11、CMPSS2)

SOC2 → 

ADC_TRIGGER_EPWM6_SOCA

SOC3 → 

ADC_TRIGGER_EPWM6_SOCA

SOC4 → 

ADC_TRIGGER_EPWM6_SOCA

SOC5 → 

ADC_TRIGGER_EPWM6_SOCA

SOC6 → 

ADC_TRIGGER_EPWM6_SOCA

SOC7 → 

ADC_TRIGGER_EPWM6_SOCA

SOC8 → 

ADC_TRIGGER_EPWM6_SOCA

SOC9 → 

ADC_TRIGGER_EPWM6_SOCA

SOC10 → 

ADC_TRIGGER_EPWM6_SOCA

SOC11 → 

ADC_TRIGGER_EPWM6_SOCA

SOC12 → 

ADC_TRIGGER_EPWM6_SOCA

CLLLC_IPRIM (A9、CMPSS2)

SOC13 → ADC_TRIGGER_EPWM1_SOCA
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表 5-2. 主なアナログ信号 (続き)
ADC-A ADC-B ADC-C

低周波サンプリング信号

(10kHz)
TTPLPFC_VAC_L (A4)

SOC14 → ADC_TRIGGER_CPU1_TINT2

TTPLPFC_VAC_N (B2)

SOC10 → 

ADC_TRIGGER_CPU1_TINT2

TTPLPFC_VBUS2 (C10、CMPSS2)

SOC14 → 

ADC_TRIGGER_CPU1_TINT2

SYSTEM_ TEMP_1 (A11)

SOC15 → ADC_TRIGGER_CPU1_TINT2

SYSTEM_VREF_1_65 (B5)

SOC11 → 

ADC_TRIGGER_CPU1_TINT2

CLLLC_VSEC (C11、CMPSS2)

VSEC13 → SOC15 → 

ADC_TRIGGER_CPU1_TINT2

サンプリングなし、CMPSS のみ CLLLC_IPRIM_TANK (A12/C5、
CMPSS2)

CLLLC_ISEC_TANK (C1、CMPSS4)

表 5-3. 主なコネクタと機能

コネクタ名 機能

J33 AC 入力

J37/J38 VBUS 接続、PFC 出力、DCDC VPRIM

J7/J10 DCDC 出力接続、 DCDC VSEC

J15 12V、2A 電源

J25/J26 HSEC 制御カードのコネクタ スロット

5.1.1.1 制御カードの設定

デバイスコントロールカードの設定には、JTAG 経由の通信が必要であり、絶縁 UART ボードを使います。また、適切な

ADC 基準電圧も提供する必要があります。以下は F280039C 制御カードのリビジョン A に必要な設定です。ユーザー

は、C2000Ware (\c2000ware\boards\controlcards\TMDSCNCD280039C) にある情報シートを参照するか、または

『F280039 controlCARD 情報ガイド』 から情報を入手することもできます。

1. デバイスに対する JTAG 接続と SFRA GUI に対する UART 接続を確立するには、制御カードの S1:A を両端で 

ON (左) に設定する必要があります。 このスイッチが OFF (右) になっていると、制御カードに内蔵された絶縁 JTAG 
を使用したり、SFRA GUI でデバイスと通信したりすることはできません。

2. J1:A は、USB ケーブル用のコネクタで、Code Composer Studio™ 統合開発環境 (IDE) が実行されているホスト 

PC からデバイスへの通信に使用されます。

3. このデザインの制御ループ調整には 3.3V の基準電圧が必要です。F28003x の内部基準電圧が使用されますが、

そのためには、S3 スイッチを最も高い位置 (INT の方向) にする必要があります。

4. コンデンサは、制御カードの絶縁グランドの間 (C7:A) に接続されています。HV 電源を接続する前に取り外してくだ

さい。

最高の性能を実現するには、複数の ADC チャネルに RC フィルタ キャップを追加する必要があります。各部品の指示

子はシルクスクリーンで明示されており、アセンブリ図は TMDSCNCD280039C 用の 

C2000Ware(\c2000ware\boards\controlcards\TMDSCNCD280039C) にあります。

信号 コンデンサ部品の指示子 コンデンサ値

TTPLPFC_VBUS C46 1µF 0603

CLLLC_VSEC C43 1µF 0603

TTPLPFC_VAC C32 1µF 0603

TTPLPFC_IAC_PH1 C31 1µF 0603

TTPLPFC_IAC_PH2 C49 1µF 0603

CLLLC_ISEC_TANK C50 560pF 0603

CLLLC_ISEC C34 1µF 0603

5.1.2 ソフトウェア

このデザインのソフトウェアは、C2000 マイクロコントローラ向けデジタル電源ソフトウェア開発キット (SDK) 
(C2000WARE-DIGITALPOWER-SDK) に同梱済みです。
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5.1.2.1 Code Composer Studio 内でプロジェクトを開く

まず

1. Code Composer Studio (CCS) 統合開発環境 (IDE) ツール フォルダから Code Composer Studio をインストール

します。バージョン 12.0 またはそれ以降をお勧めします。

2. C2000WARE-DIGITAL-POWER-SDK を次のいずれかの方法でインストールします。

• C2000Ware Digital Power SDK ツール フォルダからダウンロードします。

• CCS にアクセスし、[View] → [Resource Explorer] に進みます。テキサス・インスツルメンツの Resource 
Explorer 下で C2000WARE-DIGITAL-POWER-SDK にアクセスし、[Install] ボタンをクリックします。

3. インストールが完了したら、CCS を閉じて、新しいワークスペースを開きます。CCS により自動的に powerSUITE が

検出されます。変更を有効にするために、CCS の再起動を求められることがあります。

注

デフォルトでは、SDK とともに powerSUITE がインストールされます。

ファームウェア プロジェクトは次のようにインポートできます。

CCS 内で [Project] → [Import CCS Projects] をクリックし、<SDK>/solutions/tidm_02013/f28003x/ccs にあるソリュー

ション フォルダを参照して、プロジェクトを直接インポートすることもできます。

プロジェクトの仕様が表示され、これをクリックすると、すべての依存関係を含んだプロジェクトの自己完結型フォルダが作
成されます。

5.1.2.2 プロジェクト構造
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図 5-4. プロジェクト構造の概要

プロジェクトの一般構造を図 1-1 に示します。プロジェクトがインポートされると、図 1-1 に示すように CCS 内に Project 
Explorer が表示されます。

コア アルゴリズム コードで構成される、デバイスに依存しないソリューション固有のファイルは、<solution>.c/h にありま

す。 たとえば、TTPPLPFC.c または CLLLC.h です。 
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基板固有およびデバイス固有のファイルは、<solution>_hal.c/h にあります。 このファイルは、ソリューションを実行するデ

バイス特定のドライバで構成されています。別の変調方式やデバイスを使用する場合、プロジェクト内のデバイス サポート 

ファイルを変更する以外に変更を加える必要があるのは、これらのファイルのみです。

<solution>-main.c ファイルは、プロジェクトのメイン フレームワークで構成されています。 このファイルは、システム フレ

ームワークの作成に役立つボード ファイルとソリューション ファイルの呼び出し、割り込みサービス ルーチン (ISR)、低速

なバックグラウンド タスクで構成されています。

このデザインには、obc_7_4kw、clllc、ttplpfc の 3 つの <solution> 名があります。 最大限の柔軟性を維持するために、

CLLLC コード ベースと TTPPLPFC コード ベースをできるだけ独立させることにしました。一方で、obc_7_4kw ファイル

は、TTPPFC や CLLLC に依存しない設定を含めるために必要な場所に追加されました。これにより、エンド ユーザーは

各段を独立して動作させ、必要に応じて最終設計に PFC 段または DCDC 段のさまざまなトポロジを簡単に組み込むこと

ができます。

<solution>_settings.h ファイルには、どのラボをビルドするかなどのコード構成設定が含まれています。 一方、

<solution>_user_settings.h には、ADC マッピングや GPIO などの #define マクロのような基板レベルの構成が含まれ

ています。 

solution.js ファイルには、各ラボの実行中に観測対象に関連する変数を入力するのに役立つスクリプト ファイルが含まれ

ています。これらのスクリプトを使用するには、スクリプト コンソール ([View] - [Scripting Console]) を開きます。

solution.js ファイルの内容をスクリプト コンソールに貼り付け、[Enter] キーを押してください。これにより、後でデバッグに

使用するための [Expressions] ウィンドウに入力されます。

ソリューション名は、ソリューションで使用されるすべての変数のモジュール名および定義としても使用されます。そのた
め、すべての変数および関数呼び出しの前に CLLLC 名が追加されます (CLLLC_vSecSensed_pu など)。この命名規

則により、名前の競合を回避しながら、異なるソリューションを組み合わせることができます。

図 5-5. CLLLC プロジェクトの Project Explorer ビュー
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OBC プロジェクトは、C28x コア と CLA コアの 2 つのコアで動作する 3 つの ISR (ISR1、ISR2、ISR3) で構成されてい

ます。ISR1 のトリガに ePWM、ISR2 のトリガに eCAP、ISR3 のトリガに ADC を使用することで、ISR の優先順位をハー

ドウェアで完全に制御できます。表 5-4 に、各 ISR がどのように分割され、どのようなタスクが実行されるかを示します。

表 5-4. ISR の分割とタスク

ISR トリガ ソース C28x CLA

ISR1 (120kHz) ePWM 該当なし CLLLC PWM 値の更新

ISR2 (120kHz) eCAP PFC 電流ループ CLLLC 制御コード、ISR1 有効化

ISR3 (10kHz) ADC PFC 電圧ループ、計測 該当なし

ISR1 は、PWM 更新のために予約された最速かつネスト不可能な ISR で、すべて CLA で実行されます。ISR1 は、

PRIM_LEG1_PWM_BASE → EPWM_INT_TBCTR_U_CMPC イベントでトリガされます。一般に、この割り込みは、

PRIM_LEG1_PWM_BASE に対して考えられるすべての TBPRD レジスタ値よりも大きい値を CMPC に書き込むことに

よって無効にされます。これは、CLLLC_HAL_setupISR1Trigger 関数で行います。この ISR に関連する定義は以下の

とおりです。

#define CLLLC_ISR1_PERIPHERAL_TRIG_BASE CLLLC_PRIM_LEG1_PWM_BASE
#define CLLLC_ISR1_TRIG INT_EPWM1
#define CLLLC_ISR1_PIE_GROUP INTERRUPT_ACK_GROUP3

#define CLLLC_ISR1_TRIG_CLA CLA_TRIGGER_EPWM1INT

ISR2 は両方のコアに分割されます。これにより、TTPLPFC と CLLLC のコードを簡単にモジュール化できます。C28x で
実行される ISR2 と CLA で実行される ISR2 は、どちらも同じソースによってトリガされ、同時に動作します。C28x コアは 

TTPPLPFC に関連するタスクを実行し、CLA コアは CLLLC の実行に関連するタスクを実行します。

ISR2 は、ISR1 が必要なときに、CMPC への書き込みによって ISR1 をトリガするために有効な値を書き込む役割を担っ

ています。(注：CMPC は、これを可能にするためにグローバル負荷メカニズムに接続されていません。また、CMPC のシ

ャドウ負荷は無効にされています。)CMPC 値を調整して、ISR1 から目的のタイミングを得ることができます。ISR1 が有効

になるたびに、2 回トリガされます。最初の ISR1 では、PWM レジスタが更新され、同期が有効になります。2 回目の 

ISR1 では、PWM 同期が無効にされ、CMPC は ISR1 が再度トリガされないような値に設定されます。分かりやすくする

ために、ソフトウェア構成図と構造には、最初にトリガされた ISR1 のみが示されています。

ISR2 は ISR2_FREQUENCY で定期的にトリガされます。予備の CAP モジュールを使用して、タイム ベースを生成し、

割り込みをトリガします。予備の ePWM モジュールも同じタイム ベースで構成されており、ADC 変換のトリガに使用され

ます。ISR2 は、制御規則を実行し、PWM に必要なクロック ティックを計算する役割を担っています。シャドウ レジスタへ

の書き込みが完了すると、ISR2 は有効な値 (現在の TBPRD レジスタより小さい値) を CMPC レジスタに書き込むこと

で、ISR1 トリガを有効にします。ISR2 には、1 次側から 2 次側への電力フロー用と 2 次側から 1 次側への電力フロー用

の ISR2_primToSecPowerFlow と ISR2_secToPrimPowerFlow の 2 つのバリエーションがあります。これは、さまざま

な方向の電力フローを制御するときに CPU サイクルを最適化するために行われます。分かりやすくするために、各ラボで

はどちらも ISR2 と呼ばれています。タイミングによっては、ISR1 は、タイミングが非常に重要な更新の書き込みのために 

ISR2 をネストすることがあります。この ISR に関連する定義は以下のとおりです。

#define CLLLC_ISR2_ECAP_BASE ECAP1_BASE
#define CLLLC_ISR2_PWM_BASE EPWM5_BASE
#define CLLLC_ISR2_TRIG INT_ECAP1
#define CLLLC_ISR2_PIE_GROUP INTERRUPT_ACK_GROUP4

#define CLLLC_ISR2_TRIG_CLA CLA_TRIGGER_ADCA2

ISR3 はすべて C28x コアで実行され、ADCINT2 によってトリガされます。ADCINT2 は、CPU タイマを使用して開始さ

れる変換によって開始されます。TTPPLPFC の電圧ループの実行や、電流と電圧信号の移動平均を計算してノイズを除
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去するなどのハウスキーピング機能に使用されます。コマンド リファレンスのスルーレート機能を実行するのにも使用され

ます。

#define CLLLC_ISR3_TIMEBASE CLLLC_TASKC_CPUTIMER_BASE
#define CLLLC_ISR3_PERIPHERAL_TRIG_BASE ADCC_BASE
#define CLLLC_ISR3_TRIG INT_ADCC2

#define CLLLC_ISR3_PIE_GROUP INTERRUPT_ACK_GROUP10

これにより、割り込みを簡単にネストできます。図 1-1 は、3 つの割り込みのネストを示しています。この図は、開ループの

システムで、[Watch] ウィンドウを通して周期の変化が開始され、ISR1 トリガが 1 回だけ観測されたときのものです。閉ル

ープのシステムの場合、周期はある制御 ISR サイクルから他の制御 ISR サイクルへとわずかに変化するだけであるた

め、ISR1 は繰り返しトリガされます。

ISR1

ISR2

ISR3

図 5-6. 3 階層にネストされた ISR

さらに、CPU タイマは、低速なバックグラウンド タスクのトリガに使用されます (割り込み駆動ではなく、ポーリング)。

A タスクは、100Hz の TASKA_FREQ でトリガされます。SFRA GUI はこのレートで呼び出す必要があります。1 つのタス

ク A1 がこのレートで実行されます。

B タスクは、10Hz の TASKB_FREQ でトリガされます。これらは、一部の基本的な LED トグルや、タイミングが重要では

ないステート マシンの項目に使用されます。3 つのタスク (B1、B2、B3) がこれによって処理されるため、それぞれの実行

レートは 3.33Hz です。

#define TASKA_FREQ 100
#define TASKB_FREQ 10

このリファレンス デザインのソフトウェアは、ソリューションごとに分けられたラボで構成されており、それぞれにインクリメン

タル ビルド (INCR_BUILD) があります。これらのテストによって、システムの立ち上げや設計が簡略化されます。

CLLLC ラボ

ラボ 1：1 次側から 2 次側への電力フロー、PWM ドライバの開ループ チェック (基板に大電力が印加されていない状

態)。セクション 5.2.2.1 を参照してください。
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ラボ 2：1 次側から 2 次側への電力フロー、PWM ドライバおよび保護付き ADC の開ループ チェック (2 次側に抵抗性

負荷が接続されている状態)。セクション 5.2.2.2 を参照してください。

ラボ 3：1 次側から 2 次側への電力フロー、閉電圧ループ チェック (2 次側に抵抗性負荷が接続されている状態)。セクシ

ョン 5.2.2.3 を参照してください。

ラボ 4：1 次側から 2 次側への電力フロー、閉電流ループ チェック (2 次側に抵抗性負荷が接続されている状態)。セクシ

ョン 5.2.2.4 を参照してください。

ラボ 5：1 次側から 2 次側への電力フロー、閉電流ループ チェック (2 次側で抵抗性負荷が電圧源と並列に接続されて

バッテリ接続をエミュレートしている状態)。セクション 5.2.2.5 を参照してください。

これらの定義は settings.h ファイル内にあり、そのファイル内で直接変更できます。
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5.2 テストと結果

5.2.1 テストのセットアップ (初期設定)

このデザインのテストを開始するためのハードウェア テストのセットアップを、図 1-1 示します。ハードウェアの詳細なセット

アップについては、セクション 5.1.1 で説明しています。

J100

J103

J101

J102

Vprim

+

± 

DC Power Supply

(400 V, 8.5 Amps)

Load

(40-� Power Resistor)Vsec

Current

Probe 1

Current

Probe 2

Power Flow

5V DC, 2 Amps

Prim Side

Power Supply

5V DC, 1 Amps

Sec Side

Power Supply

図 5-7. ソフトウェアを実行するためのハードウェアセットアップ

5.2.2 CLLLC のテスト手順

5.2.2.1 ラボ 1.1 次側から 2 次側への電力フロー、PWM ドライバの開ループ チェック

このラボ オプションは、リファレンス デザインのハードウェア接続とは無関係に実行できるように、主にソフトウェアの観点

から PWM だけにフォーカスしたテストとして行われます。このラボでは、C2000 の制御カードまたはローンチパッドでコ

ードを実行し、PWM 波形を観測することができます。

ロードと実行に使用される手順は、セクション 5.2.2.2 と同様です。

PWM ドライバに変更がなければ、このラボをスキップしてラボ 2 に直接進むこともできます。このことから、このラボの手順

は、主に PWM ドライバの開発とデバッグが目的であるため、文書化されていません。

5.2.2.2 ラボ 2.1 次側から 2 次側への電力フロー、PWM ドライバおよび保護付き ADC の開ループ チェック (2 次側に抵抗性負荷が

接続されている状態)

このビルドでは、基板は [Watch] ウィンドウから変更可能な指定された周波数で開ループ方式で励起されます。周波数は 

CLLLC_pwmPeriodRef_pu 変数で制御されます。

このビルドでは、電力段からの帰還値のセンシングと PWM ゲート ドライバの動作を検証し、ハードウェアに問題がないこ

とを確認します。また、このビルドでは入出力電圧センシングの較正も実行できます。このビルドのソフトウェア構成図を、
図 1-1 に示します。
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ISR1

ISR3

ISR2

CLLLC_pwmFrequency_Hz

PWMSYSCLOCK_FREQ / 

(CLLLC_pwmPeriodMax_ticks * 

CLLLC_pwmPeriod_pu)

CLLLC_calculatePWMDut

yPeriodPhaseShiftTicks()

CLLLC_pwmDutyPrimRef_pu

CLLLC_pwmDutyPrim_pu

CLLLC_pwmDutySecRef_pu

CLLLC_pwmDutySec_pu

CLLLC_pwmPhaseShiftPrimSecRef_ns

CLLLC_pwmPhaseShiftPrimSec_ns

CLLLC_pwmPeriod_ticks

CLLLC_pwmDutyAPrim_ticks

CLLLC_pwmDutyASec_ticks

CLLLC_pwmDutyBSec_ticks

CLLLC_pwmPhaseShiftPrimSec_ticks

CLLLC_HAL_updatePWM

DutyPeriodPhaseShift()

Variables shown in red are the only ones that must be changed or observed from the watch window, these are declared as volatiles

CLLLC_pwmDeadBandREDPrimRef_ns

CLLLC_pwmDeadBandFEDPrimRef_ns

CLLLC_pwmDeadBandREDSecRef_ns

CLLLC_pwmDeadBandFEDSecRef_ns

CLLLC_calculatePWM

DeadBandPrimTicks()
CLLLC_HAL_updatePWM

DeadBandPrim()

CLLLC_pwmDeadBandREDPrim_ticks

CLLLC_pwmDeadBandFEDPrim_ticks

CLLLC_pwmDeadBandREDSec_ticks

CLLLC_pwmDeadBandFEDSec_ticks

CLLLC_HAL_updatePWM

DeadBandSec()
CLLLC_calculatePWM

DeadBandSecTicks()

CLLLC Resonant Tank

CLLLC_vPrimSensed_pu

CLLLC_iPrimSensed_pu

CLLLC_vSecSensed_pu

CLLLC_iSecSensed_pu

CLLLC_pwmPeriod_pu

CLLLC_pwmPeriodMax_ticks

CLLLC_readSensedSignals()

CLLLC_closeGiLoop !=1 &&

CLLLC_closeGvLoop !=1

CLLLC_pwmPeriodRef_pu

EMAVG_RUN

EMAVG_RUN

CLLLC_VSEC_OPTIMAL_RANGE

CLLLC_ISEC_MAX_SENSE

CLLLC_vPrimSensed_Volts

CLLLC_iPrimSensed_Amps

EMAVG_RUN

EMAVG_RUN

CLLLC_IPRIM_MAX_SENSE

CLLLC_VPRIM_MAX_SENSE

CLLLC_iPrimSensed_Amps

CLLLC_vPrimSensed_Volts

CLLLC_HAL_clearPWMTripFlags()CLLLC_clearTrip ==1

ISEC_TANK

IPRIM

VPRIM

IPRIM_TANK

VSEC

ISEC

IPRIM_TANK_2

図 5-8. ラボ 1 とラボ 2 のソフトウェア構成図

5.2.2.2.1 ラボ 2 のソフトウェア オプションの設定

1. 開始するには、セクション 5.1.2.1 で説明したように、CCS プロジェクトを開きます。

2. このビルドでは、settings.h ファイルに以下の定義が設定されています。

#if CLLLC_LAB == 2
#define CLLLC_CONTROL_RUNNING_ON CLA_CORE
#define CLLLC_POWER_FLOW CLLLC_POWER_FLOW_PRIM_SEC
#define CLLLC_INCR_BUILD CLLLC_OPEN_LOOP_BUILD
#define CLLLC_TEST_SETUP CLLLC_TEST_SETUP_RES_LOAD
#define CLLLC_PROTECTION CLLLC_PROTECTION_ENABLED

#if CLLLC_SFRA_ALLOWED == 1
#define CLLLC_SFRA_TYPE  CLLLC_SFRA_VOLTAGE
#else
#define CLLLC_SFRA_TYPE  CLLLC_SFRA_DISABLED
#endif

#define CLLLC_SFRA_AMPLITUDE (float32_t)CLLLC_SFRA_INJECTION_AMPLITUDE_LEVEL2
#endif
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5.2.2.2.2 プロジェクトのビルドおよびロードとデバッグ環境の設定

1. プロジェクト名を右クリックし、[Rebuild Project] をクリックします。

2. プロジェクトが正常にビルドされます。

3. [Project Explorer] で、targetConfigs 下で適切な目標構成ファイルが有効になっていることを確認します (図 1-1 を
参照)。

4. その後、[Run] → [Debug] をクリックしてデバッグ セッションを開始します。 デュアル CPU デバイスの場合、デバッグ

を実行する CPU を選択するウィンドウが表示されます。ここでは、CPU1 を選択します。

5. プロジェクトがデバイスにロードされ、CCS デバッグ ビューが有効になります。コードはメイン ルーチンの開始で停止

します。
6. [Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ ボックスを開きます。このコンソールの右上隅で、[Open] をクリックして、プロジェクト 

フォルダ内にある setupdebugenv_lab2and7.js スクリプト ファイルを参照します。 このファイルにより、[Watch] ウィン

ドウに、システムをデバッグするのに必要な適切な変数が入力されます。

7. [Watch] ウィンドウで [Continuous Refresh] ボタン ( ) をクリックして、コントローラからの値の連続更新を有効にし

ます。 図 1-1 に示すように [Watch] ウィンドウが表示されます。

図 5-9. ラボ 2 [Expression] ウィンドウ

5.2.2.2.3 リアルタイム エミュレーションの使用

リアルタイム エミュレーションは、マイクロコントローラ動作中に Code Composer Studio 内のウィンドウを更新できる特別

なエミュレーション機能です。 この機能により、グラフおよび Watch ビューが更新されるだけでなく、[Watch] ウィンドウや 

[Memory] ウィンドウで値を変更したり、プロセッサを停止することなくシステムにおける変更の反映を確認したりできます。

1. マウス ポインタを水平ツールバーのボタンの上に置き、

 ボタンをクリックして、リアルタイム モードを有効に

します。
2. メッセージ ボックスが表示されることがあります。その場合は [YES] を選択して、デバッグ イベントを有効にします。こ

れにより、ステータス レジスタ 1 (ST1) のビット 1 (DGBM ビット) が 0 に設定されます。DGBM は、デバッグ イネー

ブル マスク ビットです。DGBM ビットが「0」に設定されると、メモリ値とレジスタ値がホスト プロセッサに渡されて、デバ

ッガのウィンドウが更新できるようになります。
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5.2.2.2.4 コードの実行

1.  をクリックしてプロジェクトを実行します。

2. ここで、CLLLC_clearTrip 変数に 1 を書き込んで検出をクリアします。

3. Watch ビューで、CLLLC_vPrimSensed_Volts、CLLLC_iPrimSensed_Amps、CLLLC_vSecSensed_Volts、

CLLLC_iSecSensed_Amps の各変数が定期的に更新されているかどうかチェックします。(注：この時点では電力が

印加されていないため、これらの値はゼロに近くなっています。)
4. 入力 VPRIM DC 電圧を 0V から 400V に徐々に上げます。CLLLC_vPrimSensed_Volts に正しい値が表示されて

いることを確認します。
5. デフォルトでは CLLLC_pwmPeriodRef_pu 変数は、図 1-1 に示すように 0.599 に設定されており、これは 

500.8kHz です。これは、コンバータの直列共振周波数に近いですが、実際のハードウェアに搭載されている部品の

ばらつきが原因で、直列共振周波数より低くなったり、高くなったりします。たとえば、図 1-1 では、直列共振周波数よ

りもわずかに低い周波数が確認できます。
6. VSEC 変数は、設計したタンク ゲインに応じて、300V 近い電圧を示します。CLLLC_vSecSensed_Volts が正しい

電圧を示していることを確認します。これにより、基板の電圧センシングが検証されます。

図 5-10. ラボ 2 [Expression] ウィンドウ、共振時

1. テスト条件で指定された負荷では、PRIM 側と SEC 側からの電流は、CLLLC_iPrimSensed_Amps で 4.8A、

CLLLC_iSecSensed_Amps で 6.8A になります。

図 5-11. ラボ 2、共振時の 1 次側 (ch2) 電流と 2 次側 (ch3) 電流
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1. 次に、さまざまな周波数 (共振より高い周波数、共振より低い周波数) での動作を確認するには、

CLLLC_pwmPeriodRef_pu 変数を 639kHz の周波数に対応する 0.47 に変更します。この条件での波形を 図 1-1 
に示します。

図 5-12. ラボ 2、直列共振周波数を上回る 1 次側 (ch2) 電流と 2 次側 (ch3) 電流

1. 次に、CLLLC_pwmPeriodRef_pu に 0.8 を入力して、直列共振周波数を下回る状態で動作をテストします。これに

より、生成周波数は 374kHz になります。この場合、1 次側電流は不連続になり、2 次側のデューティ サイクルが変

調して、図 1-1 に示すダイオード エミュレーションが実現されます。

2. これにより、基本的なレベルで PWM ドライバとハードウェアの接続を検証できます。

図 5-13. ラボ 2、直列共振周波数を下回る 1 次側 (ch2) 電流と 2 次側 (ch3) 電流

5.2.2.2.5 電圧ループに対する SFRA プラントの測定

1. このビルドのソフトウェアには SFRA が統合されているため、プラントの応答を測定して、補償器の設計に使用できま

す。SFRA を実行するには、プロジェクトを実行したまま、<Install directory 
>\C2000Ware_DigitalPower_SDK_<version>\libraries\sfra\gui\SFRA_GUI.exe に移動します。

2. SFRA GUI でデバイスのオプションを選択します。たとえば、F280039 の場合は浮動小数点を選択します。[Setup 
Connection] をクリックします。ポップアップ ウィンドウで [Boot on Connect] オプションを選択解除し、適切な COM 
ポートを選択します。 [OK] をクリックします。SFRA GUI に戻り、[Connect] をクリックします。

3. SFRA GUI がデバイスに接続します。これで [Start Sweep] をクリックして、SFRA 掃引を開始できるようになりまし

た。SFRA 掃引が完了するまでには数分かかります。SFRA GUI のプログレス バーを確認したり、UART の動作を示

す制御カード裏面の青色 LED の点滅をチェックすることで、動作を監視できます。完了すると、図 1-1 に示すように

測定結果のグラフが表示されます。(ループが閉じていないため、ラボでは開ループ測定は無効です。プラント測定の

みを参照してください)。
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図 5-14. 閉電圧ループに対する SFRA 開ループ プロット (Vprim 400V、Vsec 300V、電力 1.972kW、Fsw 500kHz)

また、周波数応答データは SFRA データ フォルダ下のプロジェクト フォルダに保存され、SFRA 実行時のタイム スタン

プが記録されます。SFRA は、システムの動作範囲をカバーするために、異なる周波数設定ポイントで実行できます。補

償器は、これらの測定プロットを使用して次のラボで設計されるため、このタイム スタンプを覚えておくか、SFRA.csv ファ

イルの名前をわかりやすいものに変更してください。

異なる周波数ポイントで分析を繰り返してください。プラント ゲインは周波数ポイントによって異なります。333kHz で測定

されたゲインについては 図 1-1 を、680kHz で測定されたゲインについては 図 1-1 を参照してください。このことから、コ

ンバータの周波数範囲全体で安定した補償器を選択する必要があります。すべての実行結果は CSV ファイルに保存さ

れ、Compensation Designer にインポートして動作範囲全体の安定性をチェックできます。
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図 5-15. 閉電圧ループに対する SFRA 開ループ プロット (Vprim 400V、Vsec 320V、電力 2.174kW、Fsw 333kHz)

図 5-16. 閉電圧ループに対する SFRA 開ループ プロット (Vprim 400V、Vsec 293V、電力 1.828kW、Fsw 680kHz)
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5.2.2.2.6 アクティブ同期整流の検証

1. オプションとして、アクティブ同期整流を検証するために、PWM 信号をプローブしてデューティ サイクルの変化を確

認することもできます。プローブを接続するには、まず以下の手順で出力段を停止し、テスト対象の回路すべての電
源をオフにする必要があります。

図 5-17. アクティブ同期整流のチェック、ch1 → IPRIM_TANK、ch2 → ISEC_TANK、ch3/ch4 → 
SEC_LEG1_PWMH/L

2. 終了したら、入力電圧 VPRIM をゼロまで下げます。[Watch] ウィンドウの電圧がゼロまで下がるのを確認します。

3. リアルタイム モードのマイクロコントローラを完全に停止するには、2 段階の手順を踏みます。まず、ツールバーの 

[Halt] ボタン ( ) を使用するか、[Target] → [Halt] の順にクリックして、プロセッサを停止します。 次に、  をクリ

ックして、マイクロコントローラをリアルタイム モードから解除します。最後に、マイクロコントローラ ( ) をリセットしま

す。

4. [Terminate Debug Session] ( ) ([Target] → [Terminate all]) をクリックして、CCS デバッグセッションを終了しま

す。

5.2.2.2.7 電流ループに対する SFRA プラントの測定

1. SYSCFG ページに戻り、SFRA オプションで電流を選択して電流ループ プラントを測定します

2. プロジェクトをリビルドし、リロードします。2 (セクション 5.2.2.2.1) から セクション 5.2.2.2.7 (セクション 5.2.2.2.5) を繰

り返します。今回は、SFRA 掃引によってプラントの電流ループが測定されます。この CSV ファイルは、後でラボ 3 
で使用するために保存してください。すべての動作条件がカバーされていることを確認するために、複数ポイントでの
測定が可能です。図 1-1 に、500kHz での電流ループ プラントの測定結果を示します。
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図 5-18. 電流ループに対する SFRA プラントの測定 (Vprim 400V、Vsec 295V、スイッチング周波数 500kHz、
1887W)

3. これでこのビルドのチェックは完了し、このビルドが正常に終了した時点で次の項目を検証します。

a. 電圧および電流の検出とスケーリングが適正であること

b. ISR1、ISR2、ISR3 における BUILD 1 コードの割り込み生成および実行

c. PWM ドライバおよびスイッチング

d. 電流と電圧ループのプラント測定

問題が確認された場合には、ビルドの問題を解消するためにハードウェアを慎重に点検する必要があります。
4. これでコントローラを停止し、デバッグ接続を終了できます。

5. リアルタイム モードのマイクロコントローラを完全に停止するには、2 段階の手順を踏みます。まず、ツールバーの 

[Halt] ボタン ( ) を使用するか、[Target] → [Halt] の順にクリックして、プロセッサを停止します。次に、  をクリ

ックして、マイクロコントローラをリアルタイム モードから解除します。最後に、マイクロコントローラ ( ) をリセットしま

す。

6. [Terminate Debug Session] ( ) ([Target] → [Terminate all]) をクリックして、CCS デバッグセッションを終了しま

す。

5.2.2.3 ラボ 3.1 次側から 2 次側への電力フロー、閉電圧ループ チェック (2 次側に抵抗性負荷が接続されている状態)

このラボでは、電圧ループ GV は出力側に抵抗性負荷が接続された状態で閉じています。このビルドのソフトウェア構成

図を 図 1-1 に示します。ハードウェアは、図 1-1 に示すように設定されているものとします。
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ISR1

ISR3

ISR2

CLLLC_pwmFrequency_Hz

PWMSYSCLOCK_FREQ / 

(CLLLC_pwmPeriodMax_ticks * 

CLLLC_pwmPeriod_pu)

CLLLC_calculatePWMDut

yPeriodPhaseShiftTicks()

CLLLC_pwmDutyPrimRef_pu

CLLLC_pwmDutyPrim_pu

CLLLC_pwmDutySecRef_pu

CLLLC_pwmDutySec_pu

CLLLC_pwmPhaseShiftPrimSecRef_ns

CLLLC_pwmPhaseShiftPrimSec_ns

CLLLC_pwmPeriod_ticks

CLLLC_pwmDutyAPrim_ticks

CLLLC_pwmDutyASec_ticks

CLLLC_pwmDutyBSec_ticks

CLLLC_pwmPhaseShiftPrimSec_ticks

CLLLC_HAL_updatePWM

DutyPeriodPhaseShift()

Variables shown in red are the only ones that must be changed or observed from the watch window, these are declared as volatiles

CLLLC_pwmDeadBandREDPrimRef_ns

CLLLC_pwmDeadBandFEDPrimRef_ns

CLLLC_pwmDeadBandREDSecRef_ns

CLLLC_pwmDeadBandFEDSecRef_ns

CLLLC_calculatePWM

DeadBandPrimTicks()
CLLLC_HAL_updatePWM

DeadBandPrim()

CLLLC_pwmDeadBandREDPrim_ticks

CLLLC_pwmDeadBandFEDPrim_ticks

CLLLC_pwmDeadBandREDSec_ticks

CLLLC_pwmDeadBandFEDSec_ticks

CLLLC_HAL_updatePWM

DeadBandSec()
CLLLC_calculatePWM

DeadBandSecTicks()

CLLLC Resonant Tank

CLLLC_vPrimSensed_pu

CLLLC_iPrimSensed_pu

CLLLC_vSecSensed_pu

CLLLC_iSecSensed_pu

CLLLC_pwmPeriod_pu

CLLLC_pwmPeriodMax_ticks

CLLLC_readSensedSignals()

CLLLC_closeGiLoop !=1 &&

CLLLC_closeGvLoop !=1

CLLLC_pwmPeriodRef_pu

EMAVG_RUN

EMAVG_RUN

CLLLC_VSEC_OPTIMAL_RANGE

CLLLC_ISEC_MAX_SENSE

CLLLC_vPrimSensed_Volts

CLLLC_iPrimSensed_Amps

EMAVG_RUN

EMAVG_RUN

CLLLC_IPRIM_MAX_SENSE

CLLLC_VPRIM_MAX_SENSE

CLLLC_iPrimSensed_Amps

CLLLC_vPrimSensed_Volts

CLLLC_HAL_clearPWMTripFlags()CLLLC_clearTrip ==1

ISEC_TANK

IPRIM

VPRIM

IPRIM_TANK

VSEC

ISEC

Gv

GV_RUN

CLLLC_vSecRef_pu CLLLC_vSecRef_Volts1 / (CLLLC_VSEC_MAX_SENSE)

CLLLC_VOLTS_PER_SECOND_SLEW

CLLLC_closeGvLoop==2

CLLLC_vSecRefSlewed_pu

IPRIM_TANK_2

図 5-19. ソフトウェア構成図：閉電圧ループ、1 次側から 2 次側への電力フロー

5.2.2.3.1 ラボ 3 のソフトウェア オプションの設定

1. このラボを実行するには、前のセクション、図 1-1 で説明したようにハードウェアが設定されていることを確認します。

高電圧電力はまだ基板に供給しないでください。
2. <install Directory>\C2000Ware_DigitalPower_SDK_<version>\libraries\sfra\gui\CompDesigner.exe を開きま

す。
3. Compensation Designer が起動し、有効な SFRA データ ファイルを選択するように促されます。ラボ 1 の実行から

補償デザイナに SFRA データをインポートし、2 極、2 ゼロの補償器を設計します。ループが閉じたときにシステムが

安定するように、設計のこの段階でより多くのマージンを確保しておくことをお勧めします。SFRA のさまざまな実行か

ら得られたプラント データをチェックして、あらゆる条件下で安定したシステムを得ることができます。たとえば、設計し

た補償器を使用した 500kHz と 300kHz における 2 つの実行は、図 1-1 と 図 1-1 に示すように安定していることが

わかります。
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図 5-20. 電圧ループの SFRA ベースのプラント測定を用いた補償器の設計、出力に抵抗性負荷が接続されている場合 

(500kHz の測定データ)
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図 5-21. 電圧ループの SFRA ベースのプラント測定を用いた補償器の設計、出力に抵抗性負荷が接続されている場合 

(333kHz の測定データ)

注

調整は DF22 方式で行われますが、DF13 はソフトウェアで実行します。これは、DF22 構造ではできないので

すが、DF13 ではソフトスタートが簡単なためです。どちらの場合も係数は同じです。本書の作成時点では、

DF12 構造は DCL では使用できません。

4. 補償器の設計が完了したら、CLLLC_settings.h ファイルで補償器の値を更新できます。

5. Compensation Designer を閉じます。

6. このビルドでは、settings.h ファイルに以下の定義が設定されています。

#if CLLLC_LAB == 3 #define CLLLC_CONTROL_RUNNING_ON CLA_CORE #define CLLLC_POWER_FLOW 
CLLLC_POWER_FLOW_PRIM_SEC #define CLLLC_INCR_BUILD CLLLC_CLOSED_LOOP_BUILD #define 
CLLLC_CONTROL_MODE CLLLC_VOLTAGE_MODE #define CLLLC_TEST_SETUP CLLLC_TEST_SETUP_RES_LOAD 
#define CLLLC_PROTECTION CLLLC_PROTECTION_ENABLED #if CLLLC_SFRA_ALLOWED == 1 #define 
CLLLC_SFRA_TYPE CLLLC_SFRA_VOLTAGE #else #define CLLLC_SFRA_TYPE CLLLC_SFRA_DISABLED #endif 
#define CLLLC_SFRA_AMPLITUDE (float32_t)CLLLC_SFRA_INJECTION_AMPLITUDE_LEVEL1 #endif

5.2.2.3.2 プロジェクトのビルドおよびロードとデバッグ環境の設定

1. プロジェクト名を右クリックし、[Rebuild Project] をクリックします。

2. プロジェクトが正常にビルドされます。

3. [Run] → [Debug] をクリックしてデバッグ セッションを開始します。 デュアル CPU デバイスの場合、デバッグを実行

する CPU を選択するウィンドウが表示されます。ここでは、CPU1 を選択します。

4. プロジェクトがデバイスにロードされ、CCS デバッグ ビューが有効になります。コードはメイン ルーチンの開始で停止

します。
5. [Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ ボックスを開きます。このコンソールの右上隅で、[Open] をクリックして、プロジェクト 

フォルダ内にある setupdebugenv_lab3.js スクリプト ファイルを参照します。 このファイルにより、[Watch] ウィンドウ

に、システムをデバッグするのに必要な適切な変数が入力されます。
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6. [Watch] ウィンドウで [Continuous Refresh] ボタン ( ) をクリックして、コントローラからの値の連続更新を有効にし

ます。

7. マウス ポインタを水平ツールバーのボタンの上に置き、

 ボタンをクリックして、リアルタイム モードを有効に

します。

ハードウェア、ソフトウェア、試験要件、試験結果 www.ti.com/ja-jp

52 EV/HEV (電気自動車とハイブリッド電気自動車) 向け、GaN 採用、7.4kW 双方向
オンボード チャージャのリファレンス デザイン

JAJU922A – OCTOBER 2022 – REVISED FEBRUARY 2024
資料に関するフィードバック (ご意見やお問い合わせ) を送信

English Document: TIDUF18
Copyright © 2024 Texas Instruments Incorporated

https://www.ti.com/jp
https://www.ti.com/jp/lit/pdf/JAJU922
https://www.ti.com/feedbackform/techdocfeedback?litnum=JAJU922A&partnum=TIDM-02013
https://www.ti.com/lit/pdf/TIDUF18


5.2.2.3.3 コードの実行

1.  をクリックしてプロジェクトを実行します。

2. ここで、CLLLC_clearTrip 変数に 1 を書き込んで検出をクリアします。 CLLLC_closeGvLoop 変数がまだ 0 に設定

されていないため、コンバータは開ループで動作します。ファームウェアにはソフトスタートが実装されていないため、

まず 1 次側と 2 次側の電圧を手動でソフトスタートします。

3. Watch ビューで、CLLLC_vPrimSensed_Volts、CLLLC_iPrimSensed_Amps、CLLLC_vSecSensed_Volts、

CLLLC_iSecSensed_Amps の各変数が定期的に更新されているかどうかチェックします。(注：この時点では電力が

印加されていないため、これらの値はゼロに近くなっています。)
4. 入力 PRIM DC 電圧を 0V から 400V に徐々に上げて、コンバータをソフトスタートします。

CLLLC_vPrimSensed_Volts に VPRIM の正しい値 (400V に近い値) が表示されていることを確認します。

5. デフォルトでは、CLLLC_pwmPeriodRef_pu 変数は 0.599 (500.8kHz) に設定されています。これは、コンバータの

直列共振周波数に近いですが、実際のハードウェアに搭載されている部品のばらつきが原因で、直列共振周波数よ
り低くなったり、高くなったりします。

6. 400V の 1 次側入力で、巻線比が 1.33 の場合、CLLLC_vSecSensed_Volts 変数は 300V 近くになります。

CLLLC_vSecRef_Volts 変数を 300V に設定します。

7. CLLLC_closeGvLoop 変数を 1 に設定します。これで電圧ループが閉じて、コントローラによる電圧制御が試行され

ます。
8. CLLC_vSecRef_Volts を 295V から 320V に変化させて、閉ループ動作をテストすると、このコマンド リファレンスに 

CLLLC_vSecSensed_Volts が追従することが確認できます。コンバータは、直列共振周波数以下、共振周波数、共

振周波数以上で動作します。電圧を 300V に戻して SFRA を実行します

5.2.2.3.4 閉電圧ループに対する SFRA の測定

1. このビルドのソフトウェアには SFRA が統合されているため、ハードウェアを測定して、設計した補償器が十分なゲイ

ン マージンと位相マージンを提供していることを検証できます。SFRA を実行するには、プロジェクトを実行したまま、

<Install directory >\C2000Ware_DigitalPower_SDK_<version>\libraries\sfra\gui\SFRA_GUI.exe に移動しま

す。

2. SFRA GUI でデバイスのオプションを選択します。たとえば、F280039 の場合は浮動小数点を選択します。[Setup 
Connection] をクリックします。ポップアップ ウィンドウで [Boot on Connect] オプションを選択解除し、適切な COM 
ポートを選択します。[OK] をクリックします。SFRA GUI に戻り、[Connect] をクリックします。

3. SFRA GUI がデバイスに接続します。これで [Start Sweep] をクリックして、SFRA 掃引を開始できるようになりまし

た。 SFRA 掃引が完了するまでには数分かかります。SFRA GUI のプログレス バーを確認したり、UART の動作を

示す制御カード裏面の青色 LED の点滅をチェックすることで、動作を監視できます。終了すると、図 1-1 のように開

ループ プロットによるグラフが表示されます。
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図 5-22. 閉電圧ループに対する SFRA 開ループ プロット (Vprim 400V、Vsec 300V、電力 1.972kW、出力に抵抗性

負荷あり)

また、周波数応答データは SFRA データ フォルダ下のプロジェクト フォルダに保存され、SFRA 実行時のタイム スタ

ンプが記録されます。

このデータは設計した補償器とほぼ一致していますが、開ループでの測定は、小信号の導入によってコンバータの 
DC ポイントがドリフトする可能性があり、それによって誤差の影響を受けやすいため、偏差が生じるのは当然のことで

す。

さまざまな電圧で SFRA をテストし、システムが動作可能な範囲全体で安定していることを確認します。

4. これにより、電圧ループの設計を検証できます。

5. システムを安全に停止させるには、入力 VPRIM 電圧をゼロまで下げます。[Watch] ウィンドウの電圧と電流がゼロに

下がるのを観測します。
6. リアルタイム モードのマイクロコントローラを完全に停止するには、2 段階の手順を踏みます。まず、ツールバーの 

[Halt] ボタン ( ) を使用するか、[Target] → [Halt] の順にクリックして、プロセッサを停止します。次に、  をクリ

ックして、マイクロコントローラをリアルタイム モードから解除します。最後に、マイクロコントローラ ( ) をリセットしま

す。
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7. [Terminate Debug Session] ( ) ([Target] → [Terminate all]) をクリックして、CCS デバッグセッションを終了しま

す。

5.2.2.4 ラボ 4.1 次側から 2 次側への電力フロー、閉電流ループ チェック (2 次側に抵抗性負荷が接続されている状態)

このラボでは、出力電流制御ループは閉じています。このビルドのソフトウェア構成図を 図 1-1 に示します。ハードウェア

は、図 1-1 に示すように設定されているものとします。

ISR1

ISR3

ISR2

CLLLC_pwmFrequency_Hz

PWMSYSCLOCK_FREQ / 

(CLLLC_pwmPeriodMax_ticks * 

CLLLC_pwmPeriod_pu)

CLLLC_calculatePWMDut

yPeriodPhaseShiftTicks()

CLLLC_pwmDutyPrimRef_pu

CLLLC_pwmDutyPrim_pu

CLLLC_pwmDutySecRef_pu

CLLLC_pwmDutySec_pu

CLLLC_pwmPhaseShiftPrimSecRef_ns

CLLLC_pwmPhaseShiftPrimSec_ns

CLLLC_pwmPeriod_ticks

CLLLC_pwmDutyAPrim_ticks

CLLLC_pwmDutyASec_ticks

CLLLC_pwmDutyBSec_ticks

CLLLC_pwmPhaseShiftPrimSec_ticks

CLLLC_HAL_updatePWM

DutyPeriodPhaseShift()

Variables shown in red are the only ones that must be changed or observed from the watch window, these are declared as volatiles

CLLLC_pwmDeadBandREDPrimRef_ns

CLLLC_pwmDeadBandFEDPrimRef_ns

CLLLC_pwmDeadBandREDSecRef_ns

CLLLC_pwmDeadBandFEDSecRef_ns

CLLLC_calculatePWM

DeadBandPrimTicks()
CLLLC_HAL_updatePWM

DeadBandPrim()

CLLLC_pwmDeadBandREDPrim_ticks

CLLLC_pwmDeadBandFEDPrim_ticks

CLLLC_pwmDeadBandREDSec_ticks

CLLLC_pwmDeadBandFEDSec_ticks

CLLLC_HAL_updatePWM

DeadBandSec()
CLLLC_calculatePWM

DeadBandSecTicks()

CLLLC Resonant Tank

CLLLC_vPrimSensed_pu

CLLLC_iPrimSensed_pu

CLLLC_vSecSensed_pu

CLLLC_iSecSensed_pu

CLLLC_pwmPeriod_pu

CLLLC_pwmPeriodMax_ticks

CLLLC_readSensedSignals()

CLLLC_closeGiLoop !=1 &&

CLLLC_closeGvLoop !=1

CLLLC_pwmPeriodRef_pu

EMAVG_RUN

EMAVG_RUN

CLLLC_VSEC_OPTIMAL_RANGE

CLLLC_ISEC_MAX_SENSE

CLLLC_vPrimSensed_Volts

CLLLC_iPrimSensed_Amps

EMAVG_RUN

EMAVG_RUN

CLLLC_IPRIM_MAX_SENSE

CLLLC_VPRIM_MAX_SENSE

CLLLC_iPrimSensed_Amps

CLLLC_vPrimSensed_Volts

CLLLC_HAL_clearPWMTripFlags()CLLLC_clearTrip ==1

ISEC_TANK

IPRIM

VPRIM

IPRIM_TANK

VSEC

ISEC

Gv

GV_RUN

CLLLC_vSecRef_pu CLLLC_vSecRef_Volts1 / (CLLLC_VSEC_MAX_SENSE)

CLLLC_VOLTS_PER_SECOND_SLEW

CLLLC_closeGvLoop==2

CLLLC_vSecRefSlewed_pu

IPRIM_TANK_2

図 5-23. ラボ 4 の制御ソフトウェア構成図：閉電流ループ

5.2.2.4.1 ラボ 4 のソフトウェア オプションの設定

1. <install Directory>\C2000Ware_DigitalPower_SDK_<version>\libraries\sfra\gui\CompDesigner.exe を開きま

す。

2. Compensation Designer が起動し、有効な SFRA データ ファイルを選択するように促されます。電流ループに対す

るラボ 1 の実行から Compensation Designer に SFRA データをインポートし、2 極、2 ゼロの補償器を設計します。

ループが閉じたときにシステムが安定するように、設計のこの段階でより多くのマージンを確保しておくことをお勧めし
ます。SFRA のさまざまな実行から得られたプラント データをチェックして、あらゆる条件下で安定したシステムを得る

ことができます。
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図 5-24. 電流ループの SFRA ベースのプラント測定を用いた補償器の設計、ラボ 4

注

調整は DF22 方式で行われますが、DF13 はソフトウェアで実行します。これは、DF22 構造ではできないので

すが、DF13 ではソフトスタートが簡単なためです。どちらの場合も係数は同じです。本書の作成時点では、

DF12 構造は DCL では使用できません。

3. 補償器の設計が完了したら、CLLLC_settings.h ファイルで補償器の値を更新できます。

4. Compensation Designer を閉じます。
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5. このビルドでは、settings.h ファイルに以下の定義が設定されています。

#if CLLLC_LAB == 4 #define CLLLC_CONTROL_RUNNING_ON CLA_CORE #define CLLLC_POWER_FLOW 
CLLLC_POWER_FLOW_PRIM_SEC #define CLLLC_INCR_BUILD CLLLC_CLOSED_LOOP_BUILD #define 
CLLLC_CONTROL_MODE CLLLC_CURRENT_MODE #define CLLLC_TEST_SETUP CLLLC_TEST_SETUP_RES_LOAD 
#define CLLLC_PROTECTION CLLLC_PROTECTION_ENABLED #if CLLLC_SFRA_ALLOWED == 1 #define 
CLLLC_SFRA_TYPE CLLLC_SFRA_CURRENT #else #define CLLLC_SFRA_TYPE CLLLC_SFRA_DISABLED #endif 
#define CLLLC_SFRA_AMPLITUDE (float32_t)CLLLC_SFRA_INJECTION_AMPLITUDE_LEVEL1 #endif

5.2.2.4.2 プロジェクトのビルドおよびロードとデバッグの設定

1. プロジェクト名を右クリックし、[Rebuild Project] をクリックします。

2. プロジェクトが正常にビルドされます。

3. [Run] → [Debug] をクリックしてデバッグ セッションを開始します。 デュアル CPU デバイスの場合、デバッグを実行

する CPU を選択するウィンドウが表示されます。ここでは、CPU1 を選択します。

4. プロジェクトがデバイスにロードされ、CCS デバッグ ビューが有効になります。コードはメイン ルーチンの開始で停止

します。
5. [Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ ボックスを開きます。このコンソールの右上隅で、[Open] をクリックして、プロジェクト 

フォルダ内にある setupdebugenv_build4c.js スクリプト ファイルを参照します。 このファイルにより、[Watch] ウィンド

ウに、システムをデバッグするのに必要な適切な変数が入力されます。

6. [Watch] ウィンドウで [Continuous Refresh] ボタン ( ) をクリックして、コントローラからの値の連続更新を有効にし

ます。

7. マウス ポインタを水平ツールバーのボタンの上に置き、

 ボタンをクリックして、リアルタイム モードを有効に

します。

5.2.2.4.3 コードの実行

1.  をクリックしてプロジェクトを実行します。

2. CLLLC_clearTrip 変数に 1 を書き込み、検出をクリアします。 CLLLC_closeGvLoop 変数がまだ 0 に設定されてい

ないため、コンバータは開ループで動作します。ファームウェアにはソフトスタートが実装されていないため、まず 1 次
側と 2 次側の電圧を手動でソフトスタートします。

3. Watch ビューで、CLLLC_vPrimSensed_Volts、CLLLC_iPrimSensed_Amps、CLLLC_vSecSensed_Volts、

CLLLC_iSecSensed_Amps の各変数が定期的に更新されているかどうかチェックします。(注：この時点では電力が

印加されていないため、これらの値はゼロに近くなっています。)
4. 入力 PRIM DC 電圧を 0V から 400V に徐々に上げて、コンバータをソフトスタートします。

CLLLC_vPrimSensed_Volts に VPRIM の正しい値 (400V に近い値) が表示されていることを確認します。

5. デフォルトでは、CLLLC_pwmPeriodRef_pu 変数は 0.6 (500.8kHz) に設定されています。これは、コンバータの直

列共振周波数に近いですが、実際のハードウェアに搭載されている部品のばらつきが原因で、直列共振周波数より
低くなったり、高くなったりします。

6. 400V の 1 次側入力 で、巻線比が 1.33 の場合、CLLLC_vSecSensed_Volts 変数は 300V 近くになります。また、

テスト条件で指定されている負荷の場合、負荷は 6.5A 近くになります。CLLLC_iSecRef_Amps 変数を 6.5A に設

定します。何らかの理由で測定電流が 6.5A と異なる場合は、Ref を測定値に近い値に設定してください。ソフトウェ

アにはソフトスタートがないため、この基準を動作ポイントに近づけることが重要です。
7. CLLLC_closeGiLoop 変数を 1 に設定します。これで電流ループが閉じて、コントローラによる電流制御が試行され

ます。
8. CLLC_iSecRef_Amps を 6.3A から 6.8A に変化させて、閉ループ動作をテストします。出力に抵抗性負荷が接続さ

れており、その電圧はバッテリよりも電流に対して大きく変化するため、ユーザーは電流を大きく変化させることはでき
ません。このような急激な電圧上昇によって、コンバータはすぐに固定された VPRIM の制御可能範囲を超える可能

性があります。狭い範囲内であれば、電流トラッキングを確認できます。

www.ti.com/ja-jp ハードウェア、ソフトウェア、試験要件、試験結果

JAJU922A – OCTOBER 2022 – REVISED FEBRUARY 2024
資料に関するフィードバック (ご意見やお問い合わせ) を送信

EV/HEV (電気自動車とハイブリッド電気自動車) 向け、GaN 採用、7.4kW 双方向
オンボード チャージャのリファレンス デザイン

57

English Document: TIDUF18
Copyright © 2024 Texas Instruments Incorporated

https://www.ti.com/jp
https://www.ti.com/jp/lit/pdf/JAJU922
https://www.ti.com/feedbackform/techdocfeedback?litnum=JAJU922A&partnum=TIDM-02013
https://www.ti.com/lit/pdf/TIDUF18


5.2.2.4.4 閉電流ループに対する SFRA の測定

1. このビルドのソフトウェアには SFRA が統合されているため、ハードウェアを測定して、設計した補償器が十分なゲイ

ン マージンと位相マージンを提供していることを検証できます。SFRA を実行するには、プロジェクトを実行したまま、

<Install directory >\C2000Ware_DigitalPower_SDK_<version>\libraries\sfra\gui\SFRA_GUI.exe に移動しま

す。 SFRA GUI が表示されます。

2. SFRA GUI でデバイスのオプションを選択します。たとえば、F280039 の場合は浮動小数点を選択します。[Setup 
Connection] をクリックします。ポップアップ ウィンドウで [Boot on Connect] オプションを選択解除し、適切な COM 
ポートを選択して、[OK] をクリックします。SFRA GUI に戻り、[Connect] をクリックします。

3. SFRA GUI がデバイスに接続します。これで [Start Sweep] をクリックして、SFRA 掃引を開始できるようになりまし

た。SFRA 掃引が完了するまでには数分かかります。SFRA GUI のプログレス バーを確認したり、UART の動作を示

す制御カード裏面の青色 LED の点滅をチェックすることで、動作を監視できます。終了すると、図 1-1 のように開ル

ープ プロットによるグラフが表示されます。

図 5-25. 閉電流ループに対する SFRA 開ループ プロット (Vprim 400V、Vsec 300V、電力 1.972kW、ラボ 4)

また、周波数応答データは SFRA データ フォルダ下のプロジェクト フォルダに保存され、SFRA 実行時のタイム スタ

ンプが記録されます。

このデータは設計した補償器とほぼ一致していますが、開ループでの測定は、小信号の導入によってコンバータの 
DC ポイントがドリフトする可能性があり、それによって誤差の影響を受けやすいため、偏差が生じるのは当然のことで

す。
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さまざまな電流設定ポイントで SFRA をテストし、周期が制限されていないことを確認して、システムが動作可能な範

囲全体で安定していることを確認します。
4. これにより、ラボ 4 の電流ループの設計を検証できます。

5. システムを安全に停止させるには、入力 VPRIM 電圧をゼロまで下げます。[Watch] ウィンドウの電圧と電流がゼロに

下がるのを観測します。
6. リアルタイム モードのマイクロコントローラを完全に停止するには、2 段階の手順を踏みます。まず、ツールバーの 

[Halt] ボタン ( ) を使用するか、[Target] → [Halt] の順にクリックして、プロセッサを停止します。次に、  をクリ

ックして、マイクロコントローラをリアルタイム モードから解除します。最後に、マイクロコントローラ ( ) をリセットしま

す。

7. [Terminate Debug Session] ( ) ([Target] → [Terminate all]) をクリックして、CCS デバッグセッションを終了しま

す。

5.2.2.5 ラボ 5.1 次側から 2 次側への電力フロー、閉電流ループ チェック (2 次側で抵抗性負荷が電圧源と並列に接続されてバッテ

リ接続をエミュレートしている状態)

このラボでは、出力電流制御ループが閉じており、2 次側で抵抗性負荷が電圧源と並列に接続され、バッテリ接続をエミ

ュレートしています。ハードウェアは、図 1-1 に示すように設定されているものとします。このビルドのソフトウェア構成図を 

図 1-1 に示します。
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図 5-26. ラボ 5 のハードウェア セットアップ
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ISR1

ISR3

ISR2

CLLLC_pwmFrequency_Hz

PWMSYSCLOCK_FREQ / 

(CLLLC_pwmPeriodMax_ticks * 

CLLLC_pwmPeriod_pu)

CLLLC_calculatePWMDut

yPeriodPhaseShiftTicks()

CLLLC_pwmDutyPrimRef_pu

CLLLC_pwmDutyPrim_pu

CLLLC_pwmDutySecRef_pu

CLLLC_pwmDutySec_pu

CLLLC_pwmPhaseShiftPrimSecRef_ns

CLLLC_pwmPhaseShiftPrimSec_ns

CLLLC_pwmPeriod_ticks

CLLLC_pwmDutyAPrim_ticks

CLLLC_pwmDutyASec_ticks

CLLLC_pwmDutyBSec_ticks

CLLLC_pwmPhaseShiftPrimSec_ticks

CLLLC_HAL_updatePWM

DutyPeriodPhaseShift()

Variables shown in red are the only ones that must be changed or observed from the watch window, these are declared as volatiles

CLLLC_pwmDeadBandREDPrimRef_ns

CLLLC_pwmDeadBandFEDPrimRef_ns

CLLLC_pwmDeadBandREDSecRef_ns

CLLLC_pwmDeadBandFEDSecRef_ns

CLLLC_calculatePWM

DeadBandPrimTicks()
CLLLC_HAL_updatePWM

DeadBandPrim()

CLLLC_pwmDeadBandREDPrim_ticks

CLLLC_pwmDeadBandFEDPrim_ticks

CLLLC_pwmDeadBandREDSec_ticks

CLLLC_pwmDeadBandFEDSec_ticks

CLLLC_HAL_updatePWM

DeadBandSec()
CLLLC_calculatePWM

DeadBandSecTicks()

CLLLC Resonant Tank

CLLLC_vPrimSensed_pu

CLLLC_iPrimSensed_pu

CLLLC_vSecSensed_pu

CLLLC_iSecSensed_pu

CLLLC_pwmPeriod_pu

CLLLC_pwmPeriodMax_ticks

CLLLC_readSensedSignals()

EMAVG_RUN

EMAVG_RUN

CLLLC_VSEC_OPTIMAL_RANGE

CLLLC_ISEC_MAX_SENSE

CLLLC_vPrimSensed_Volts

CLLLC_iPrimSensed_Amps

EMAVG_RUN

EMAVG_RUN

CLLLC_IPRIM_MAX_SENSE

CLLLC_VPRIM_MAX_SENSE

CLLLC_iPrimSensed_Amps

CLLLC_vPrimSensed_Volts

CLLLC_HAL_clearPWMTripFlags()CLLLC_clearTrip ==1

ISEC_TANK

IPRIM

VPRIM

IPRIM_TANK

VSEC

ISEC

Gv

GV_RUN

CLLLC_vSecRef_pu CLLLC_vSecRef_Volts1 / (CLLLC_VSEC_MAX_SENSE)

CLLLC_VOLTS_PER_SECOND_SLEW

CLLLC_closeGiLoop==1

CLLLC_vSecRefSlewed_pu

IPRIM_TANK_2

CLLLC_clearTrip ==1

図 5-27. ラボ 5 のソフトウェア構成図
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5.2.2.5.1 ラボ 5 のソフトウェア オプションの設定

1. <install Directory>\C2000Ware_DigitalPower_SDK_<version>\libraries\sfra\gui\CompDesigner.exe を開きま

す。

5.2.2.5.2 電流ループ補償器の設計

1. Compensation Designer が起動します。現在のところ、数学モデルが利用できないため、この基板で行われた調整

を利用して、以下のような補償が設計されています。バッテリ エミュレーション モードのプラントではゲインが大きくな

るため、それに対応するために係数を下げる必要があります。図 1-1 に、このラボでこのデザインに使用されている各

係数を示します。

図 5-28. ラボ 5、Compensation Designer
2. 補償器の設計が完了したら、CLLLC_settings.h ファイルで補償器の値を更新できます。係数は控えめにして、ラボ 

3 で使用したものよりもはるかに低くするのが最善です。

3. Compensation Designer を閉じます。

4. このビルドでは、settings.h ファイルに以下の定義が設定されています。

#if CLLLC_LAB == 5 #define CLLLC_CONTROL_RUNNING_ON 1 #define CLLLC_POWER_FLOW 
CLLLC_POWER_FLOW_PRIM_SEC #define CLLLC_INCR_BUILD CLLLC_CLOSED_LOOP_BUILD #define 
CLLLC_CONTROL_MODE CLLLC_CURRENT_MODE #define CLLLC_TEST_SETUP 
CLLLC_TEST_SETUP_EMULATED_BATTERY #define CLLLC_PROTECTION CLLLC_PROTECTION_ENABLED #if 
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CLLLC_SFRA_ALLOWED == 1 #define CLLLC_SFRA_TYPE CLLLC_SFRA_CURRENT #else #define 
CLLLC_SFRA_TYPE CLLLC_SFRA_DISABLED #endif #define CLLLC_SFRA_AMPLITUDE 
(float32_t)CLLLC_SFRA_INJECTION_AMPLITUDE_LEVEL1 #endif
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5.2.2.5.3 プロジェクトのビルドおよびロードとデバッグの設定

1. プロジェクト名を右クリックし、[Rebuild Project] をクリックします。

2. プロジェクトが正常にビルドされます。

3. [Run] → [Debug] をクリックしてデバッグ セッションを開始します。 デュアル CPU デバイスの場合、デバッグを実行

する CPU を選択するウィンドウが表示されます。ここでは、CPU1 を選択します。

4. プロジェクトがデバイスにロードされ、CCS デバッグ ビューが有効になります。コードはメイン ルーチンの開始で停止

します。
5. [Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ ボックスを開きます。このコンソールの右上隅で、[Open] をクリックして、プロジェクト 

フォルダ内にある setupdebugenv_build4.js スクリプト ファイルを参照します。 このファイルにより、[Watch] ウィンド

ウに、システムをデバッグするのに必要な適切な変数が入力されます。

6. [Watch] ウィンドウで [Continuous Refresh] ボタン ( ) をクリックして、コントローラからの値の連続更新を有効にし

ます。

7. マウス ポインタを水平ツールバーのボタンの上に置き、

 ボタンをクリックして、リアルタイム モードを有効に

します。

5.2.2.5.4 コードの実行

1.  をクリックしてプロジェクトを実行します。

2. 入力 PRIM DC 電圧を 0V から 400V に徐々に上げます。CLLLC_vPrimSensed_Volts に VPRIM の正しい値 

(400V に近い値) が表示されていることを確認します。この時点で PWM がトリップし、1 次側からは電流が流れませ

ん。
3. VSEC を 300V に上げます。2 次側に接続されている電源からすべての電流が負荷に流れ込み、6.5A 近くになりま

す。
4. CLLLC_iSecRef_Amps 変数を 0.1A に設定します。

5. CLLLC_clearTrip 変数に 1 を書き込み、検出をクリアします。 このラボのソフトウェアによって CLLLC_closeGiLoop 
変数が自動的に 1 に設定されます。

6. 固定された 1 次側電圧での電圧範囲が狭いことが原因で、コンバータは最も高い周波数まで飽和し、ISEC での引

き込み電流は 0.1A を上回ります。ユーザーは、CLLLC_pwmFrequency_Hz 変数を監視することでこの状態を観察

することができます。CLLLC_pwmFrequency_Hz 変数は、飽和上限時には 800kHz 近くなり、飽和下限時に 

200kHz 近くになります。

7. 電流を徐々に 2A～3A に上げます。これで、電流は 2 次側に接続された電圧源とテスト中デバイス (DUT) とで共有

されます。

5.2.2.5.5 バッテリ エミュレーション モードでの閉電流ループに対する SFRA 測定

1. このビルドのソフトウェアには SFRA が統合されているため、ハードウェアを測定して、設計した補償器が十分なゲイ

ン マージンと位相マージンを提供していることを検証できます。SFRA を実行するには、プロジェクトを実行したまま、

<Install directory >\C2000Ware_DigitalPower_SDK_<version>\libraries\sfra\gui\SFRA_GUI.exe に移動しま

す。 SFRA GUI が表示されます。

2. SFRA GUI でデバイスのオプションを選択します。たとえば、F280039 の場合は浮動小数点を選択します。[Setup 
Connection] をクリックします。ポップアップ ウィンドウで [Boot on Connect] オプションを選択解除し、適切な COM 
ポートを選択して、[OK] をクリックします。SFRA GUI に戻り、[Connect] をクリックします。

3. SFRA GUI がデバイスに接続します。これで [Start Sweep] をクリックして、SFRA 掃引を開始できるようになりまし

た。SFRA 掃引が完了するまでには数分かかります。SFRA GUI のプログレス バーを確認したり、UART の動作を示

す制御カード裏面の青色 LED の点滅をチェックすることで、動作を監視できます。終了すると、図 1-1 のように開ル

ープ プロットによるグラフが表示されます。
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図 5-29. バッテリ接続をエミュレートした状態の閉電流ループに対する SFRA 開ループ プロット (Vprim 400V、Vsec 
300V、電力 1.972kW、ラボ 5)

また、周波数応答データは SFRA データ フォルダ下のプロジェクト フォルダに保存され、SFRA 実行時のタイム スタ

ンプが記録されます。

さまざまな電流設定ポイントで SFRA をテストし、周期が制限されていないことを確認して、システムが動作可能な範

囲全体で安定していることを確認します。
4. これにより、ラボ 5 の電流ループ設計を検証できます。

5. システムを安全に停止させるには、入力 VPRIM 電圧をゼロまで下げます。[Watch] ウィンドウの電圧と電流がゼロに

下がるのを観測します。
6. リアルタイム モードのマイクロコントローラを完全に停止するには、2 段階の手順を踏みます。まず、ツールバーの 

[Halt] ボタン ( ) を使用するか、[Target] → [Halt] の順にクリックして、プロセッサを停止します。次に、  をクリ

ックして、マイクロコントローラをリアルタイム モードから解除します。最後に、マイクロコントローラ ( ) をリセットしま

す。

7. [Terminate Debug Session] ( ) ([Target] → [Terminate all]) をクリックして、CCS デバッグセッションを終了しま

す。
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5.2.3 TTPLPFC のテスト手順

5.2.3.1 ラボ 1：開ループ、DC

このビルドでは、固定デューティ サイクルにより基板は開ループ方式で励起されます。デューティ サイクルは

dutyPU_DC 変数で制御されます。このビルドでは、電力段からの帰還値のセンシングと PWM ゲート ドライバの動作を

検証し、ハードウェアに問題がないことを確認します。また、このビルドでは入出力電圧センシングの較正も実行できま
す。このビルドのソフトウェア構造を図 1-1 に示します。このシステムには、電流ループ用の高速 ISR、電圧ループおよび

計測機能を実行する低速 ISR という 2 つの ISR があります。各 ISR で実行されるモジュールを 図 1-1 に示します 

(TIDM-02013 は 2 相インターリーブ TTPPLPFC であることに注意してください)。

Single Phase 
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+

PWM dutyPU

+
-ac_vol_sensed

DCL_DF22 DCL_DF22

4th Order Notch Filter

Compute 

Average

vBus_sensedFilteredNotch2

10 Khz, Voltage Loop and Instrumentation ISR

100 Khz,

Current Loop ISR

DLOG_4CH

input_ptr1 output_ptr1
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output_ptr3 DBUFF3
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ac_cur_sensed
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Read 

ADC

&

Scale 

to PU

図 5-30. ビルド レベル 1 の制御ソフトウェア構成図：開ループ プロジェクト

5.2.3.1.1 BUILD 1 のソフトウェアオプションの設定

TTPLPFC_settings.h を開き、Lab1 を有効にします。

#define TTPLPFC_LAB 1

5.2.3.1.2 プロジェクトのビルドおよびロード

プロジェクト名を右クリックし、[Rebuild Project] をクリックします。
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プロジェクトが正常にビルドされます。

Project Explorer で、targetConfigs 下で適切な目標構成ファイルが有効になっていることを確認します。

[Run] → [Debug] をクリックします。 この操作によりデバッグ セッションが起動します。デュアル CPU デバイスの場合に

は、ウィンドウが表示され、デバッグを実行する必要がある CPU を選択できます。ここでは、CPU1 を選択します。

するとプロジェクトがデバイスにロードされ、CCS デバッグ ビューが有効になります。メイン ルーチンの開始時にコードは

停止します。

5.2.3.1.3 デバッグ環境設定ウィンドウ

[Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ ボックスを開きます。 このコンソールの右上隅で、[Open] をクリックして、プロジェクト フォ

ルダ内にある setupdebugenv_lab1.js スクリプト ファイルを参照します。このスクリプトファイルにより、Watch ウィンドウ

に、システムをデバッグするのに必要な適切な変数が入力されます。[Watch] ウィンドウで [Continuous Refresh] ボタン

をクリックして、コントローラからの値の連続更新を有効にします。図 1-1 に示すように Watch ウィンドウが表示されます。

図 5-31. ビルドレベル 1 の Expressions ビュー

 をクリックしてプロジェクトを実行します。

ここでツールバーの [Halt] ボタン ( ) をクリックして、プロセッサを停止します。

5.2.3.1.4 リアルタイム エミュレーションの使用

リアルタイム エミュレーションは、マイクロコントローラ動作中に CCS 内のウィンドウを更新できる特別なエミュレーション機

能です。この機能により、グラフおよび Watch ビューが更新されるだけでなく、[Watch] ウィンドウや [Memory] ウィンドウ

で値を変更したり、プロセッサを停止することなくシステムにおける変更の反映を確認したりできます。

マウス ポインタを水平ツールバーのボタンの上に置き、  ボタンをクリックして、リアルタイム モードを有効にします。

メッセージ ボックスが表示されることがあります。その場合は [YES] を選択して、デバッグ イベントを有効にします。 この

操作により、ステータス レジスタ 1 (ST1) のビット 1 (DGBM ビット) が「0」に設定されます。DGBM は、デバッグ イネーブ

ル マスク ビットです。DGBM ビットが「0」に設定されると、メモリ値とレジスタ値がホスト プロセッサに渡されて、デバッガの

ウィンドウが更新できるようになります。

5.2.3.1.5 コードの実行

 をクリックしてプロジェクトを再度実行します。
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数秒後、突入リレーのクリック音がします。DC によりこのビルドレベルでそれを実行するようにソフトウェアがプログラミング

されます。検出がクリアされ、デューティ サイクル 0.5 が適用されます。

Watch ビューで、guiVin、guiVbus、guiIi の各変数が定期的に更新されているかどうかチェックします。電力が印加されて

いないため、この値はゼロに近くなっています。

入力 DC 電圧をゼロから 120V まで徐々に上げていきます。デフォルト設定で 0.5PU の安定したデューティ サイクルが

適用されるため、出力電圧は昇圧を示します。大電流が引き出された場合、電圧端子が逆接続されていないかどうかを確
認します。そうであれば、まず電圧をゼロに下げ、問題を修正してからテストを再開します。

TTPLPFC_vBusAvg_pu に正しい値が表示されていることを確認して、電圧センシングを検証します。 DC 120V 入力の

場合、これにより、基板の電圧検出をある程度検証できます。

dutyPU_DC 変数を変更して、さまざまな昇圧条件下での動作を確認できます。これにより、PWM ドライバとハードウェア

の接続を基本的なレベルで検証できます。

終了したら、入力電圧をゼロに下げ、バス電圧がゼロまで下がるのを見届けます。

これで、このビルドのチェックは完了です。このビルドが正常に完了すると、以下の項目が検証されます。

• 電圧と電流のセンシングとスケーリングの精度

• 電流ループ ISR および電圧ループ計測 ISR における BUILD 1 コードの割り込み生成および実行

• PWM ドライバおよびスイッチング

問題が確認された場合には、ビルドの問題など解消するためにハードウェアを慎重に点検する必要があります。

これでコントローラを停止し、デバッグ接続を終了できます。

リアルタイム モードのマイクロコントローラを完全に停止するには、2 段階の手順を踏みます。まず、ツールバーの [Halt] 

ボタン ( ) を使用するか [Target] → [Halt] の順にクリックしてプロセッサを停止します。 次に、  をクリックして、マイ

クロコントローラをリアルタイム モードから解除します。最後に、  をクリックしてマイクロコントローラをリセットします。

[Terminate Debug Session] ( ) ([Target] → [Terminate all]) をクリックして、CCS デバッグ セッションを終了します。

5.2.3.2 ラボ 2：閉電流ループ DC

BUILD 2 では、内部電流ループが閉じているため、電流補償器 Gi を使用してインダクタ電流を制御します。DC バスと

出力電圧フィード フォワードの両方をこの電流補償器の出力に印加して、インバータのデューティ サイクルを生成しま

す。これにより、電流補償器用構成が簡素になり、比例(P)コントローラを使用して内部電流のループを調整できます。電

流ループのモデルが導き出されています。このビルドのソフトウェア構成図を 図 1-1 に示します (TIDM-02013 は 2 相イ

ンターリーブ TTPPLPFC であることに注意してください)。

( )ac _ cur _meas ac _ cur _ ref _ inst Gi ac _ vol_ sensed
duty1PU

vBus _ sensed

- ´ +
=

(21)

このビルドのソフトウェア構成図を図 1-1 に示します。
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図 5-32. ビルド レベル 2 の制御ソフトウェア構成図：閉電流ループ

5.2.3.2.1 BUILD 2 のソフトウェアオプションの設定

セクション 5.1.1 で説明されているように、ハードウェアがスタンドアローン PFC 動作用に設定されていることを確認しま

す。高電圧(HV)電力はまだ基板に供給しないでください。

TTPLPFC_settings.h を開き、Lab2 を有効にします。

#define TTPLPFC_LAB 2

その他のすべてのオプションが セクション 5.2.3.2 で指定したものと同じであることを確認します。
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1. Compensation Designer (<install 
Directory>\C2000Ware_DigitalPower_SDK_<version>\libraries\sfra\gui\CompDesigner.exe) を開きます。

5.2.3.2.2 電流ループ補償器の設計

Compensation Designer が起動します。PI コントローラを極零の観点から調整して、安定した閉ループ動作を確保でき

ます。設計した補償器を使用するシステムの安定性は、図 1-1 に示す Compensation Designer の開ループ伝達関数プ

ロットで利得マージンと位相マージンを観測して検証できます。

図 5-33. Compensation Designer を使用した電流ループ設計

開ループ ゲインが完了したら、ttplpfc_settings.h ファイルで補償器の値を更新できます。

Compensation Designer を閉じます。

5.2.3.2.3 プロジェクトのビルドおよびロードとデバッグの設定

プロジェクト名を右クリックし、[Rebuild Project] をクリックします。 プロジェクトが正常にビルドされます。Run → Debug を

クリックして、デバッグセッションを起動します。デュアル CPU デバイスの場合、ウィンドウが表示され、デバッグを実行する

必要がある CPU を選択できます。ここでは、CPU1 を選択します。するとプロジェクトがデバイスにロードされ、CCS デバ

ッグ ビューが有効になります。メイン ルーチンの開始時にコードは停止します。

www.ti.com/ja-jp ハードウェア、ソフトウェア、試験要件、試験結果

JAJU922A – OCTOBER 2022 – REVISED FEBRUARY 2024
資料に関するフィードバック (ご意見やお問い合わせ) を送信

EV/HEV (電気自動車とハイブリッド電気自動車) 向け、GaN 採用、7.4kW 双方向
オンボード チャージャのリファレンス デザイン

69

English Document: TIDUF18
Copyright © 2024 Texas Instruments Incorporated

https://www.ti.com/jp
https://www.ti.com/jp/lit/pdf/JAJU922
https://www.ti.com/feedbackform/techdocfeedback?litnum=JAJU922A&partnum=TIDM-02013
https://www.ti.com/lit/pdf/TIDUF18


[Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ ボックスを開きます。 このコンソールの右上隅で、[Open] をクリックして、プロジェクト フォ

ルダ内にある setupdebugenv_lab2.js スクリプト ファイルを参照します。 このファイルにより、[Watch] ウィンドウに、シス

テムをデバッグするのに必要な適切な変数が入力されます。[Watch] ウィンドウで [Continuous Refresh] ボタン ( ) を
クリックして、コントローラからの値の連続更新を有効にします。 図 1-1 のように [Watch] ウィンドウが表示されます。

図 5-34. ビルド レベル 2：閉電流ループ Expressions ビュー

マウス ポインタを水平ツールバーのボタンの上に置き、  ボタンをクリックして、リアルタイム モードを有効にします。

 をクリックしてプロジェクトを実行します。

ここでツールバーの [Halt] ボタン ( ) をクリックして、プロセッサを停止します。

5.2.3.2.4 コードの実行

このプロジェクトは、設定時間(autoStartSlew==100)を過ぎたら突入リレーを駆動し、検出をクリアするようにプログラミン

グされています。DC によりこのビルドレベルでそれを実行するようにソフトウェアがプログラミングされます。Run ボタンをク

リックしてからこの autoslew カウンタが 100 に達するまでに、入力電圧を印加する必要があります。入力時に電圧を印加

する前にカウンタが 100 に達した場合は、コードをリセットする必要があります。このためコントローラをリアルタイムモード

から解除する必要があり、リセットを実行し、再起動します。セクション 5.2.3.2.3 のステップを繰り返し、マウス ポインタを

水平ツールバーのボタンの上に置き、  ボタンをクリックして、リアルタイム モードを有効にします。

 をクリックしてプロジェクトを実行します。

autoStartSlew が 100 に達する前に、約 50V の入力電圧を印加します。autoStartSlew が 100 に達するとすぐに、突入

リレーが駆動され、PWM 検出がクリアされるのと同時に電流ループフラグを閉じます。
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図 5-35. Watch 式、ビルド ラボ 2、閉電流ループ動作開始後の DC

入力電流は約 1.5A に制御され、出力電圧は約 193V に上昇します。

ac_cur_ref を 0.045 すなわち 2.4A 入力まで徐々に上げていきます。

Vin を 120V に徐々に上げていくと、出力電圧が 370V を上回ります。

図 5-36. Watch 式、ビルド ラボ 2、フル電圧での閉電流ループ動作開始後の DC

このビルドのソフトウェアには SFRA が統合されているため、ハードウェアを測定して、設計した補償器が十分なゲイン マ
ージンと位相マージンを提供していることを検証できます。SFRA を実行するには、プロジェクトを実行したまま、<Install 
directory >\C2000Ware_DigitalPower_SDK_<version>\libraries\sfra\gui\SFRA_GUI.exe に移動します。 SFRA 
GUI が表示されます。

SFRA GUI でデバイスのオプションを選択します。例として、F28003x の場合には浮動小数点を選択します。[Setup 
Connection] をクリックします。ポップアップ ウィンドウで [Boot on Connect] オプションを選択解除し、適切な COM ポー

トを選択します。[Boot on Connect] が選択解除されていることを確認します。[OK] をクリックします。SFRA GUI に戻り、

[Connect] をクリックします。
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SFRA GUI がデバイスに接続します。これで [Start Sweep] をクリックして、SFRA 掃引を開始できるようになりました。

SFRA 掃引が完了するまでには数分かかります。SFRA GUI のプログレスバーを確認したり、UART の動作を示す制御

カード裏面の青色 LED の点滅をチェックすることで、動作を監視できます。終了すると、開ループプロットによるグラフが

表示されます。また、周波数応答データは SFRA データ フォルダ下のプロジェクト フォルダに保存され、SFRA 実行時

のタイムスタンプが記録されます。

さらに、プラントの周波数応答の測定値は、Compensation Designer(<install 
Directory>\C2000Ware_DigitalPower_SDK_<version>\libraries\sfra\gui\CompDesigner.exe) を使用して電流補償

器を設計するために使用できます。

GUI でプラントオプションに SFRA Data を選択します。これは、測定したプラントの情報を用いて補償器を設計するもの

です。このオプションを使用して補償を微調整できます。デフォルトでは、Compensation Designer は最新の SFRA 実
行を示しています。過去の SFRA 実行時のプラント情報を使用する必要がある場合、[Browse SFRA Data] をクリックし、

参照して SFRAData.csv ファイルを選択してください。 この操作により、電流補償器設計を検証できます。

入力 DC 電圧をゼロまで下げて、システムを安全に停止させます。guiVBus もゼロに下がっていることを確認します。

リアルタイム モードのマイクロコントローラを完全に停止するには、2 段階の手順を踏みます。まず、ツールバーの [Halt] 

ボタン ( ) を使用するか [Target] → [Halt] の順にクリックしてプロセッサを停止します。 次に、  をクリックしてマイク

ロコントローラをリアルタイム モードから解除します。最後に、マイクロコントローラ ( ) をリセットします。

[Terminate Debug Session] ( ) ([Target] → [Terminate all]) をクリックして、CCS デバッグセッションを終了します。 

5.2.3.3 ラボ 3：閉電流ループ、AC

ラボ 3 では、内部電流ループが閉じているため、電流補償器 Gi を使用してインダクタ電流を制御します。DC バスと出力

電圧フィード フォワードの両方をこの電流補償器の出力に印加して、ゼロクロス周りの PWM ソフトスタートとともにインバ

ータのデューティ サイクルを生成します。

このビルドのソフトウェア構成図を 図 1-1 に示します (TIDM-02013 は 2 相インターリーブ TTPPLPFC であることに注意

してください)。
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図 5-37. ビルド ラボ 3 の制御ソフトウェア構成図：閉電流ループ AC

5.2.3.3.1 ラボ 3 のソフトウェア オプションの設定

TTPLPFC_settings.h を開き、Lab3 を有効にします。

#define TTPLPFC_LAB 3

過去のビルドの電流補償器をこのビルドで再利用するため、ビルドの電流ループを調整する追加手順は必要ありません。
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5.2.3.3.2 プロジェクトのビルドおよびロードとデバッグの設定

プロジェクト名を右クリックし、[Rebuild Project] をクリックします。 プロジェクトが正常にビルドされます。Run → Debug を

クリックして、デバッグセッションを起動します。デュアル CPU デバイスの場合、ウィンドウが表示され、デバッグを実行する

必要がある CPU を選択できます。ここでは、CPU1 を選択します。するとプロジェクトがデバイスにロードされ、CCS デバ

ッグ ビューが有効になります。メイン ルーチンの開始時にコードは停止します。

[Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ ボックスを開きます。 このコンソールの右上隅で、[Open] をクリックして、プロジェクト フォ

ルダ内にある setupdebugenv_Lab3.js スクリプト ファイルを参照します。 このファイルにより、[Watch] ウィンドウに、シス

テムをデバッグするのに必要な適切な変数が入力されます。[Watch] ウィンドウで [Continuous Refresh] ボタン ( ) を
クリックして、コントローラからの値の連続更新を有効にします。 図 1-1 のように [Watch] ウィンドウが表示されます。

図 5-38. ラボ 3 AC：閉電流ループ Expressions ビュー

マウス ポインタを水平ツールバーのボタンの上に置き、  ボタンをクリックして、リアルタイム モードを有効にします。

5.2.3.3.3 コードの実行

このプロジェクトは、入力電圧が約 70Vrms を上回るまで待機してから突入リレーを駆動し、検出をクリアするようにプログラ

ミングされています。

 をクリックしてプロジェクトを実行します。

約 120V の入力電圧を印加すると、基板は低電圧状態から脱し、突入リレーが駆動されます。検出がクリアされ、約 1.3A 
RMS の少量の電流が流れます。Watch ウィンドウの外観は図 1-1 と同様です。バス電圧はほぼ 270 V です。
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図 5-39. Watch 式、ラボ 2、閉電流ループ動作開始後の AC

ac_cur_ref を 0.078、すなわち 2.4A 入力まで徐々に上げていくと、バス電圧が 400V まで上昇します。電圧と電流の波

形を 図 1-1 に示します。

図 5-40. 入力 AC 電流と出力 DC 電圧の波形

このビルドのソフトウェアには SFRA が統合されているため、ハードウェアを測定して、設計した補償器が十分なゲイン マ
ージンと位相マージンを提供していることを検証できます。SFRA を実行するには、プロジェクトを実行したまま、<Install 
directory >\C2000Ware_DigitalPower_SDK_<version>\libraries\sfra\gui\SFRA_GUI.exe に移動します。 SFRA 
GUI が表示されます。
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SFRA GUI でデバイスのオプションを選択します。例として、F280039 の場合には浮動小数点を選択します。[Setup 
Connection] をクリックします。ポップアップ ウィンドウで [Boot on Connect] オプションを選択解除し、適切な COM ポー

トを選択します。[OK] をクリックします。SFRA GUI に戻り、[Connect] をクリックします。

SFRA GUI がデバイスに接続します。これで [Start Sweep] をクリックして、SFRA 掃引を開始できるようになりました。

SFRA 掃引が完了するまでには数分かかります。SFRA GUI のプログレス バーを確認したり、UART の動作を示す制御

カード裏面の青色 LED の点滅をチェックすることで、動作を監視できます。終了すると、開ループプロットによるグラフが

表示されます。これは DC 条件下のプロットと似ていますが、測定周波数付近に AC 高調波による若干の追加ノイズが確

認されます。BW、PM、GM の数値は DC の場合と非常に似通っています。

システムを安全に停止させるには、AC 電源からの出力をオフにし、入力 AC 電圧をゼロまで下げます。guiVbus もゼロ

に下がっていることを確認します。

リアルタイム モードのマイクロコントローラを完全に停止するには、2 段階の手順を踏みます。まず、ツールバーの [Halt] 

ボタン ( ) を使用するか、[Target] → [Halt] の順にクリックして、プロセッサを停止します。 次に、  をクリックしてマ

イクロコントローラをリアルタイム モードから解除します。最後に、マイクロコントローラ ( ) をリセットします。

[Terminate Debug Session] ( ) ([Target] → [Terminate all]) をクリックして、CCS デバッグセッションを終了します。 

5.2.3.4 ラボ 4：閉電圧および電流ループ

このビルドでは、外部電圧ループも内部電流ループも閉じています。外部電圧ループのモデルは 図 1-1 に示されていま

す (TIDM-02013 は 2 相インターリーブ TTPPLPFC であることに注意してください)。PI 補償器を使用して、外部電圧ル

ープを Compensation Designer で調整します。

図 1-1 にこのビルドのソフトウェア構成図を示します。
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図 5-41. ビルド レベル 4 の制御図：内部電流ループによる出力電圧制御

5.2.3.4.1 BUILD 4 のソフトウェアオプションの設定

セクション 5.1.1 で説明されているように、ハードウェアがスタンドアローン PFC 動作用に設定されていることを確認しま

す。高電圧(HV)電力はまだ基板に供給しないでください。

TTPLPFC_settings.h を開き、Lab4 を有効にします。

#define TTPLPFC_LAB 4

その他のすべてのオプションが 図 1-1 で指定したものと同じであることを確認します。
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1. Compensation Designer (<install 
Directory>\C2000Ware_DigitalPower_SDK_<version>\libraries\sfra\gui\CompDesigner.exe) を開きます。

5.2.3.4.2 プロジェクトのビルドおよびロードとデバッグの設定

プロジェクト名を右クリックし、[Rebuild Project] をクリックします。 プロジェクトが正常にビルドされます。Run → Debug を

クリックして、デバッグセッションを起動します。デュアル CPU デバイスの場合、ウィンドウが表示され、デバッグを実行する

必要がある CPU を選択できます。ここでは、CPU1 を選択します。するとプロジェクトがデバイスにロードされ、CCS デバ

ッグ ビューが有効になります。メイン ルーチンの開始時にコードは停止します。

[Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ ボックスを開きます。 このコンソールの右上隅で、[Open] をクリックして、プロジェクト フォ

ルダ内にある setupdebugenv_lab4.js スクリプト ファイルを参照します。 このファイルにより、[Watch] ウィンドウに、シス

テムをデバッグするのに必要な適切な変数が入力されます。[Watch] ウィンドウで [Continuous Refresh] ボタン ( ) を
クリックして、コントローラからの値の連続更新を有効にします。

図 1-1 に示すように [Watch] ウィンドウが表示されます。

図 5-42. ビルド ラボ 4：Expressions ビュー

マウス ポインタを水平ツールバーのボタンの上に置き、  ボタンをクリックして、リアルタイム モードを有効にします。

 をクリックしてプロジェクトを実行します。

ここでツールバーの [Halt] ボタン ( ) をクリックして、プロセッサを停止します。

5.2.3.4.3 コードの実行

このプロジェクトは、入力電圧が約 70Vrms を上回るまで待機してから突入リレーを駆動し、検出をクリアするようにプログラ

ミングされています。

 をクリックしてプロジェクトを実行します。
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約 120V の入力電圧を印加すると、基板は低電圧状態から脱し、突入リレーが駆動されます。検出がクリアされ、出力が 

DC 380V まで上昇します。AC 入力から正弦波電流が引き出されます。この段でプログラムを実行しているときの 

[Watch] ウィンドウを 図 1-1 に示します。

図 5-43. ビルド ラボ 4：AC 電圧を印加した後の Expressions ビュー

このビルドのソフトウェアには SFRA が統合されているため、ハードウェアを測定して、設計した補償器が十分なゲイン マ
ージンと位相マージンを提供していることを検証できます。SFRA を実行するには、プロジェクトを実行したまま、<Install 
directory >\C2000Ware_DigitalPower_SDK_<version>\libraries\sfra\gui\SFRA_GUI.exe に移動します。 SFRA 
GUI が表示されます。

SFRA GUI でデバイスのオプションを選択します。例として、F28003x の場合には浮動小数点を選択します。[Setup 
Connection] をクリックし、ポップアップ ウィンドウで [Boot on Connect] オプションを選択解除し、適切な COM ポートを

選択します。[OK] をクリックします。SFRA GUI に戻り、[Connect] をクリックします。

SFRA GUI がデバイスに接続します。これで [Start Sweep] をクリックして、SFRA 掃引を開始できるようになりました。

SFRA 掃引が完了するまでには数分かかります。SFRA GUI のプログレスバーを確認したり、UART の動作を示す制御

カード裏面の青色 LED の点滅をチェックすることで、動作を監視できます。終了すると、図 1-1 のように開ループプロット

によるグラフが表示されます。この操作により、設計した補償器が確かに安定していることを検証できます。
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図 5-44. 閉電圧ループでの SFRA 実行

別の方法として、Compensation Designer を再度開き、GUI でプラントオプションに SFRA Data を選択します。このオ

プションにより、測定したプラント情報を用いて補償器を設計し、補償を微調整できます。デフォルトでは、Compensation 
Designer は最新の SFRA 実行を示しています。過去の SFRA 実行時のプラント情報を使用する必要がある場合、

[Browse SFRA Data] をクリックし、参照して SFRAData.csv ファイルを選択してください。 Compensation Designer を
閉じて、電圧補償器の設計を検証します。

システムを安全に停止させるには、入力 AC 電圧をゼロまで下げます。guiVBus もゼロに下がっていることを確認します。

リアルタイム モードのマイクロコントローラを完全に停止するには、2 段階の手順を踏みます。まず、ツールバーの [Halt] 

ボタン ( ) を使用するか、[Target] → [Halt] の順にクリックして、プロセッサを停止します。 次に、  をクリックしてマ

イクロコントローラをリアルタイム モードから解除します。最後に、マイクロコントローラ ( ) をリセットします。

[Terminate Debug Session] ( ) ([Target] → [Terminate all]) をクリックして、CCS デバッグ セッションを終了します。

5.2.4 テスト結果

このデザインで実現できる電力密度は 3.8kW/L (62.5W/in3) です。システム全体の効率は 96.5% で、PFC の効率は 

98.5%、CLLLC の効率は 98% です。
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5.2.4.1 効率

12V バイアス電源の有無による効率データを以下の各グラフに示します。このバイアス電源は、制御、アイソレータ、ゲー

ト ドライブに電力を供給します。図 1-1 のグラフは、次の条件で取得したものです。

• VIN,RMS = 240V
• VOUT = 400V
• クーラント温度：20°C

図 5-45. PFC の効率

図 1-1 のグラフは、次の条件で取得したものです。

• VIN = 400V
• VOUT = 350V
• クーラント温度：20°C

図 5-46. CLLLC の効率

www.ti.com/ja-jp ハードウェア、ソフトウェア、試験要件、試験結果

JAJU922A – OCTOBER 2022 – REVISED FEBRUARY 2024
資料に関するフィードバック (ご意見やお問い合わせ) を送信

EV/HEV (電気自動車とハイブリッド電気自動車) 向け、GaN 採用、7.4kW 双方向
オンボード チャージャのリファレンス デザイン

81

English Document: TIDUF18
Copyright © 2024 Texas Instruments Incorporated

https://www.ti.com/jp
https://www.ti.com/jp/lit/pdf/JAJU922
https://www.ti.com/feedbackform/techdocfeedback?litnum=JAJU922A&partnum=TIDM-02013
https://www.ti.com/lit/pdf/TIDUF18


図 1-1 のグラフは、次の条件で取得したものです。

• VIN,RMS = 240V
• VOUT = 350V
• クーラント温度：20°C

図 5-47. システム効率
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5.2.4.2 システム性能

以下の図は、システム全体の効率、システム損失、全高調波歪み (THD)、正規化された出力電圧レギュレーション精度を

まとめたものです。

このデザインで実現できる電力密度は 3.8kW/L (62.5W/in3) です。これによって、システム全体の効率は 96.5% に達し

ます。1.5kW を超える負荷の THD は 5% 未満で、出力電圧のレギュレーション精度はおおむね ±0.06% 以内です。

図 1-1 のグラフは、次の条件を使用しています。

• VIN,RMS = 240V
• VOUT = 350V
• クーラント温度：20°C

図 5-48. システム性能
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5.2.4.3 ボード線図

以下のボード線図は、TMS320F28388D マイクロコントローラに搭載されているオンボード ソフトウェア周波数応答アナラ

イザを使用して取得したものです。テストで使用された負荷は定電流シンクとして構成され、マイクロコントローラは一定の
出力電圧を調整するように構成されています。帯域幅はおおよそ 1kHz～2.5kHz で、位相マージンは 45℃ を超えてい

ます。

図 5-49. 電圧ループのボード線図
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以下のボード線図は、TMS320F28388D マイクロコントローラに搭載されているオンボード ソフトウェア周波数応答アナラ

イザを使用して取得したものです。テストで使用された負荷は定電圧として構成され、マイクロコントローラは一定の出力
電流を調整するように構成されています。帯域幅はおおよそ 1kHz～2.5kHz で、位相マージンは 60℃ を超えています。

図 5-50. 電圧ループのボード線図 (定電圧負荷)

www.ti.com/ja-jp ハードウェア、ソフトウェア、試験要件、試験結果

JAJU922A – OCTOBER 2022 – REVISED FEBRUARY 2024
資料に関するフィードバック (ご意見やお問い合わせ) を送信

EV/HEV (電気自動車とハイブリッド電気自動車) 向け、GaN 採用、7.4kW 双方向
オンボード チャージャのリファレンス デザイン

85

English Document: TIDUF18
Copyright © 2024 Texas Instruments Incorporated

https://www.ti.com/jp
https://www.ti.com/jp/lit/pdf/JAJU922
https://www.ti.com/feedbackform/techdocfeedback?litnum=JAJU922A&partnum=TIDM-02013
https://www.ti.com/lit/pdf/TIDUF18


5.2.4.4 効率とレギュレーションのデータ

次の表は効率とレギュレーションのデータを示します。

VOUT (V) IOUT (A) POUT (W) VIN (V) IIN (A) PIN (W) VBIAS (V) IBIAS (A) PBIAS (W) 効率 (%) バ
イアスなし

効率 (%) バ
イアスあり

352.76 0.5 177.35 240.12 1.17 215.36 11.92 1.24 14.73 82.35 77.08

352.74 1 354.12 240.05 1.79 391.84 11.92 1.23 14.67 90.37 87.11

352.72 1.5 530.65 239.98 2.49 572.25 11.92 1.24 14.8 92.73 90.39

352.71 2 706.27 239.91 3.23 753.97 11.92 1.24 14.78 93.67 91.87

352.7 2.5 882.52 239.84 3.97 936.83 11.92 1.24 14.76 94.2 92.74

352.7 3 1058.9 239.76 4.72 1118.95 11.92 1.23 14.71 94.63 93.41

352.7 3.5 1235.3 239.69 5.48 1301.58 11.92 1.23 14.65 94.91 93.85

352.69 4 1411.74 239.62 6.23 1484.44 11.92 1.23 14.61 95.1 94.18

352.69 4.5 1587.99 239.55 6.99 1667.43 11.92 1.22 14.57 95.24 94.41

352.69 5 1763.62 239.47 7.75 1849.94 11.92 1.22 14.51 95.33 94.59

352.69 5.5 1939.96 239.4 8.51 2031.56 11.93 1.21 14.48 95.49 94.82

352.69 6 2116.85 239.32 9.27 2212.59 11.93 1.21 14.48 95.67 95.05

352.68 6.5 2293.18 239.25 10.02 2392.72 11.93 1.21 14.46 95.84 95.26

352.68 7 2469.51 239.17 10.78 2572.43 11.93 1.21 14.4 96 95.46

352.67 7.5 2645.17 239.1 11.53 2751.5 11.93 1.19 14.16 96.14 95.64

352.68 8 2821.8 239.02 12.29 2931.48 11.94 1.16 13.85 96.26 95.81

352.69 8.5 2998.24 238.95 13.04 3111.5 11.94 1.14 13.56 96.36 95.94

352.71 9 3174.78 238.87 13.8 3292.5 11.95 1.11 13.26 96.43 96.04

352.72 9.5 3350.46 238.79 14.56 3472.6 11.95 1.09 12.99 96.48 96.12

352.76 10 3527.33 238.71 15.33 3654.7 11.95 1.07 12.76 96.51 96.18

352.79 10.5 3704.19 238.63 16.09 3837.2 11.96 1.05 12.52 96.53 96.22

352.84 11 3881.08 238.54 16.87 4020.3 11.96 1.03 12.37 96.54 96.24

352.91 11.5 4058.4 238.46 17.64 4204.2 11.96 1.02 12.24 96.53 96.25

352.92 12 4235 238.37 18.42 4387.9 11.96 1.02 12.16 96.51 96.25

352.93 12.5 4411.3 238.28 19.2 4571.5 11.96 1.01 12.08 96.5 96.24

352.96 13 4588.2 238.18 19.98 4756 11.96 1 12 96.47 96.23

352.99 13.5 4765.1 238.09 20.77 4940.9 11.96 1 11.92 96.44 96.21

353 14 4941.9 237.99 21.55 5125.8 11.97 0.99 11.86 96.41 96.19

353.02 14.5 5118.9 237.89 22.34 5311.4 11.97 0.99 11.79 96.38 96.16

353.02 15 5294.8 237.79 23.13 5496.4 11.97 0.98 11.73 96.33 96.13

353.02 15.5 5471.6 237.68 23.92 5682.4 11.97 0.98 11.69 96.29 96.09

353.03 16 5648.3 237.62 24.71 5868.9 11.97 0.97 11.64 96.24 96.05

353.05 16.5 5825.2 237.51 25.51 6056.1 11.97 0.97 11.59 96.19 96

353.02 17.5 6176.6 237.26 27.13 6432.3 11.97 0.96 11.52 96.03 95.85

353.02 18 6353.2 237.14 27.94 6621.6 11.97 0.96 11.49 95.95 95.78

353.03 18.5 6529.8 237.01 28.76 6812.2 11.97 0.96 11.47 95.85 95.69

353.05 19 6706.8 236.87 29.59 7004.3 11.97 0.96 11.44 95.75 95.6
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5.2.4.5 熱データ

図 1-1 は全負荷動作時に撮影されたものです。発熱が著しい部品はすべて、基板底面のコールド プレートに接続されて

います。この画像で最も高温に見えている部品は、EMI フィルタ内にある同相モード インダクタに起因するものです。これ

らの部品はコールド プレートに接続されておらず、冷却はすべて周囲の空気を通してのみ行われます。

図 5-51. 上面の熱画像

GaN FET の温度は、LMG3522 デバイスに搭載されているオンボード温度センサで測定されます。全負荷条件では、す

べての FET 温度は 75℃ を下回ります。

表 5-5 に、以下の条件における GaN FET の測定温度を示します。

• VIN,AC：240V
• VDC,LINK：400V
• クーラント温度：33°C

表 5-5. GaN FET 測定温度

GaN FET 温度 (℃)
PFC 66.8

CLLLC 1 次側 (350V/19A) 58.1

CLLLC 2 次側 (350V/19A) 59.5

CLLLC 1 次側 (300V/19A) 61.0

CLLLC 2 次側 (300V/19A) 74.0
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図 1-1 に、以下の条件におけるトランスの臨界温度を示します。

• クーラント温度：33°C
• トランスの温度測定位置

– PRI 1 – 1 次側巻線の内側表面で測定

– PRI 2 – 1 次側巻線の外側表面で測定

– SEC 1 – 2 次側巻線の内側表面で測定

– SEC 2 – 2 次側巻線の外側表面で測定

– CORE 1 – コアのセンターレッグ上部で測定

– CORE 2 – コアのセンターレッグ下部で測定

– CORE 3 – コアの側面で測定

– CORE 4 – コアの上部で測定

図 5-52. CLLLC トランスの温度

5.2.4.6 PFC の波形

図 1-1 に、以下のパラメータで測定された PFC 入力電圧および入力電流の波形を示します。

• トレース

– C2：VIN
– C4：IIN

• 条件

– VIN = 208V
– VOUT = 400V
– ROUT = 43Ω
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図 5-53. PFC の入力電圧と入力電流

図 1-1 に、次のパラメータで測定された PFC の GaN ドレイン電圧の波形を示します。

• トレース

– C1：GaN スイッチのノード ドレイン電圧

– C2：VIN
– C4：IIN

• 条件

– VIN = 208V
– VOUT = 400V
– ROUT = 43Ω

図 5-54. PFC の GaN ドレイン電圧
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GaN スイッチのドレイン - ソース間の電圧遷移を拡大すると、図 1-1 に示すように約 20ns となります。このような急激な遷

移は、LMG3522 の COSS が低いことに起因しています。

図 1-1 の波形は、次のパラメータで測定されたものです。

• トレース

– C1：GaN スイッチのノード ドレイン電圧

– C2：VIN
– C4：IIN

• 条件

– VIN = 208V
– VOUT = 400V
– ROUT = 43Ω

図 5-55. PFC の GaN ドレイン電圧 - 遷移
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5.2.4.7 CLLLC の波形

図 1-1 に、次のパラメータを用いた 19A (6.6kW) での CLLLC 動作を示します。

• トレース

– C1：GaN 1 次側スイッチ ノードのドレイン電圧

– C2：GaN 2 次側スイッチ ノードのドレイン電圧

– C3：トランス 1 次側電流

– C4：トランス 2 次側電流

• 条件

– VIN = 400V
– VOUT = 350V
– IOUT = 19A

図 5-56. CLLLC 動作、19A (6.6kW)
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図 1-1 に、次のパラメータを用いた 10A での CLLLC 動作を示します。

• トレース

– C1：GaN スイッチのノード ドレイン電圧レッグ 1
– C2：GaN スイッチのノード ドレイン電圧レッグ 2
– C3：トランス 1 次側電流

– C4：トランス 2 次側電流

• 条件

– VIN = 400V
– VOUT = 350V
– IOUT = 10A

図 5-57. CLLLC 動作、10A
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GaN スイッチのドレイン - ソース間の電圧遷移を拡大すると、図 1-1 に示すように約 40 ns となります。このような急激な

遷移は、LMG3522 の COSS が低いことに起因しています。

図 1-1 の波形は、次のパラメータで測定されたものです。

• トレース

– C1：GaN スイッチのノード ドレイン電圧レッグ 1
– C2：GaN スイッチのノード ドレイン電圧レッグ 2
– C3：トランス 1 次側電流

– C4：トランス 2 次側電流

• 条件

– VIN = 400V
– VOUT = 350V
– IOUT = 10A

図 5-58. CLLLC 動作、10A - GaN FET の遷移
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図 1-1 の波形は、次のパラメータで測定されたものです。

• トレース

– C1：GaN スイッチのノード ドレイン電圧レッグ 1
– C2：GaN スイッチのノード ドレイン電圧レッグ 2
– C3：トランス 1 次側電流

– C4：トランス 2 次側電流

• 条件

– VIN = 400V
– VOUT = 350V
– IOUT = 2A

図 5-59. CLLLC 動作、2A
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GaN スイッチのドレイン - ソース間の電圧遷移を拡大すると、図 1-1 に示すように約 75 ns となります。このような急激な

遷移は、LMG3522 の COSS が低いことに起因しています。この図で遷移時間がわずかに長くなっているのは、負荷が軽

く、その結果として電流量が減少しているためです。

図 1-1 の波形は、次のパラメータで測定されたものです。

• トレース

– C1：GaN スイッチのノード ドレイン電圧レッグ 1
– C2：GaN スイッチのノード ドレイン電圧レッグ 2
– C3：トランス 1 次側電流

– C4：トランス 2 次側電流

• 条件

– VIN = 400V
– VOUT = 350V
– IOUT = 2A

図 5-60. CLLLC 動作、2A - GaN FET の遷移
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6 デザイン ファイル

6.1 回路図

回路図をダウンロードするには、TIDM-02013 のデザイン ファイルを参照してください。

6.2 部品表 (BOM)
部品表 (BOM) をダウンロードするには、TIDM-02013 のデザイン ファイルを参照してください。

6.3 Altium プロジェクト

Altium Designer® のプロジェクト ファイルをダウンロードするには、TIDM-02013 のデザイン ファイルを参照してくださ

い。

6.4 ガーバー ファイル

ガーバー ファイルをダウンロードするには、TIDM-02013 のデザイン ファイルを参照してください。

7 ソフトウェア ファイル

このリファレンス デザインのソフトウェアをダウンロードするには、C2000 マイクロコントローラ向けデジタル電源ソフトウェア

開発キット (SDK) のサイトにアクセスしてください。
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9 用語

略称 定義

BCM バッテリ充電モード

BW 帯域幅

CAN コントローラ エリア ネットワーク

CCM 連続導通モード

CCS Code Composer Studio

CLA 制御補償器アクセラレータ (CLA)

CLB 構成可能なロジック ブロック

CLLLC コンデンサ、インダクタ、インダクタ、インダクタ、コンデンサ

CMPSS コンパレータ サブシステム

CMTI 同相過渡耐性

DAB デュアル アクティブ ブリッジ

DAC D/A コンバータ

DCM 不連続導通モード

DLOG データ ロガー

DT デッド タイム

DUT (試験対象デバイス) テスト対象の設計

eCAP 拡張キャプチャ

ePWM 拡張パルス幅変調器

ERAD 組み込みのリアルタイム分析および診断

EV 電気自動車

FET 電界効果トランジスタ

FHA 第 1 高調波分析

FSI 高速シリアル インターフェイス

GaN 窒化ガリウム

HEV ハイブリッド電気自動車

HRPWM 高分解能パルス幅変調器

HSEC 高速エッジ カード

I2C IC の相互接続

IDE に対応したプロジェクト例を含むソー

ス コードを提供
統合開発環境

IGBT 絶縁ゲート バイポーラ トランジスタ

ISR 割り込みサービス ルーチン

KCL キルヒホッフの電流則

KVL キルヒホッフの電圧則

LIN ローカル相互接続ネットワーク

MOSFET 金属酸化膜半導体電界効果トランジスタ

OBC オンボード チャージャ

PFC 力率補正

PGA プログラマブル ゲイン アンプ

PMBus パワー マネージメント バス

SCI シリアル通信インターフェイス

SDFM シグマ-デルタ フィルタ モジュール

SFRA ソフトウェア周波数応答アナライザ

SiC シリコン カーバイド

SPI シリアル ペリフェラル インターフェイス

SRC 直列共振コンバータ

ZCS ゼロ電流スイッチング

ZVS ゼロ電圧スイッチング
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